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This Manual 

This manual is divided into two main parts: 

 Part 1 provides a brief introduction to the Notion Pro System as a whole, and gives an overview of the 
hardware that you would use with Notion Pro. 

 Part 2 gives a detailed description of the Notion Pro software. See also the Notion Pro Help.  
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1 Introduction 

1.1 What does Notion Pro do? 

IceSpy Notion Pro enables you to configure and monitor temperature sensors installed in (typically) storage 
facilities for refrigerated or frozen goods or other temperature-sensitive environments (for example ultra-cold 
and cryogenic storage in hospitals. 

Notion Pro is a System, containing software and hardware. For details of the hardware, see Section 2, also 
http://www.the-imcgroup.com/notionpro/. 

The Notion Pro software gives a graphical user interface (GUI) which works through all the main web browsers, 
for display on a desktop PC, laptop or mobile device such as a tablet or smart phone. 

1.2 Hardware Components 

A Notion Pro system contains the following hardware: 

 Transmitters to monitor the levels of temperature and other variables and transmit the data by radio to the 
Receiver. See section 2.6 for more details of the transmitters. 

 Network Receiver (may also be referred to as the Base Unit). See section 2.1 for more details of the 
Network Receiver. 

 Optional Items. These are the Echo, the ARB Module, the SMS Module and the Calibration Module. See 
sections 2.2 -2.5 for more details of these Optional Items. 

1.3 Software Components 

The Notion Pro system includes the server-based Notion Pro application software. The browser-based user 
interface enables you to monitor and control the Notion Pro system. 

A typical Notion Pro display is shown below. 

 

See Part 2 of this Manual for how to use Notion Pro software. See also the Notion Pro Help.
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2 The Notion Pro Hardware 

2.1 The Network Receiver 

 

The Network Receiver receives radio signals from the Notion Pro Transmitters and passes them over a network to the Notion Pro software. The Hybrid Receiver 
will also receive signals from IceSpy System 5 Scout, Notion pro Legacy and Notion Pro transmitters.  

Key features: 

 IMC Product Code IN-NR001-Fx (where x indicates the territory-specific frequency, for example F1 for Europe, F2 for USA; this notation will be used 
throughout this Manual). Hybrid unit is IN-HR001-Fx. 

 Wall mountable. 

 Internal aerials as standard – external aerials are a factory-fitted option. 

 Red LED for alarm (normal state off), green LED for power (normal state on), 1 yellow LED for communications (normal state on). See also section 2.1.1. 

 Mains powered from supplied adaptor.  

 TCP/IP communications. 

 Two on-board Relays, one configured for alarm activation, one for communications and power failure. 

 Memory lasts for 5 days for up to 50 sensors. 

 IP53 rated. 
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2.1.1 LEDs 

Green (constant/flashing) Unit is powered up. Flashes to indicate radio reception. 

Red (flashing) Alarm. (For example, temperature is outside thresholds.) Changes to steady red if 

Reset button is pressed. Goes off when Alarm Clear signal is received. 

Yellow (constant) Receiver is connected to your Network. A flashing yellow light means that an 
Ethernet connection has not yet been established. 

2.1.2 Connectors 

 

 

 

 

 

DC Power 
Jack Plug 

Mutes buzzer, 
cancels relay and 
changes alarm 
LED from flashing 
to steady On.  

1
st
 Relay 

2nd Relay 

Ethernet 

Flashing 
indicates 
Ethernet 
traffic 

On/Off 
indicator 

RS485 
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2.2 The Echo Module (optional) 

 

The Echo module provides a Repeater function to re-transmit signals, should this be required in your installation. Key features: 

 IMC Part No IN-RP002-Fx. 

 Wall mountable. 

 Green LED for power (normal state on), red LED to indicate signal being received, yellow LED to indicate signal being transmitted.. 

 Mains powered from supplied adaptor. 

 Battery backup for 3 days. 

 Reset button. 

 IP53 rated. 

2.2.1 Connectors 

 

(See also section 2.1.2.) 
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2.3 The SMS Module (Optional) 

 

This unit gives the ability for Transmitter alarms to be sent as SMS messages to mobile phones. See Part 2, 2.5.2 for details of SMS message configuration. 

Key features: 

 IMC Part No IN-TA001. 

 Wall-mountable. 

 External aerial. 

 Red LED for alarm (normal state off), green LED for power (normal state on), yellow LED for communications (normal state on). 

 OLED display showing signal strength and status.  

 Base push-button – quick press shows setup and signal strength, 5-second press sends SMS test message.
1
  

 On-board 2G/3G GSM module. 

 Optional Wi-Fi communications. 

 Mains powered from supplied adaptor.  

 TCP/IP communications. 

 Two on-board Relays, one configured for alarm activation, one for communications and power failure. 

                                                           
1
 The display shows signal strength, whether the unit is connected to the GSM network and whether a SIM card is fitted. When the SMS test message is sent 

the display indicates the telephone number and the message being sent. 



System Manual 

The Notion Pro Hardware 

 

 

 

 
IM5521-1 Page 15 of 174  

 

 Battery backup for 24 hours, rechargeable batteries. 

 SIM socket and card – accessed from back of battery compartment. 

 IP53 rated. 

2.3.1 Connectors 

 

 

 

(See also section 2.1.2.)  Sends SMS 
test message 
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2.4 The ARB Module (Optional) 

 

The ARB unit gives an alarm display, with a keypad enabling the user to cycle through alarm information. Has RFID and Bluetooth connectivity. 

 IMC Part No IN-NA002. 

 Wall mountable. 

 Bluetooth module to interface to MM2000 series recording thermometer. 

 Red LED for alarms (normal state off), green LED for power (normal state on), yellow LED for incoming SMS alarm message (normal state on). 

 Mains powered from supplied adaptor.   

 TCP/IP communications. 

 On-board alarm relay and reset button.. 

 RS485 output to drive IMC MS1000 system relay cards. 

 Battery backup. 

 RFID interface and cradle for transmitter backfill
2
. 

 IP53 rated.  

                                                           
2
 If a transmitted signal can’t get through for some reason, data is stored in an on-board cache. Backfill  is where the transmitter is placed close to the ARB unit, stored data is 

then transferred automatically to the ARB via RFID. 
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2.4.1 Connectors 

 

(See also section  2.1.2.)  

2.4.2 Keypad Operation 

 

  
Cycles up/down through Alarm messages for each sensor, ACKNOWLEDGE and RETURN screens. 

 
Enter/OK – see below. 

 
Bluetooth. Press to interface with MM7000 series recording thermometer and download its data.* 

 
Mute. Stops alarm buzzer 

* To download the scan data from an MM7000, first ensure that the MM7000 unit is turned on and enable the Bluetooth function by pressing the Bluetooth 
button on the MM7000). Then press the Bluetooth button on the ARB unit. If Bluetooth connection is possible an icon will appear on the screen and a number 
of dots, indicating that download is occurring. Once downloading is completed the screen will show a thumbs up symbol and then revert to normal operation. 
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2.4.3 User Interaction 

On unit power up/reset, a locale-specific welcome screen appears. Pressing OK ( ) at this point enters ARB setup mode, otherwise the display will 

automatically scroll through the Alarm screens. The display goes off after 30 seconds. 

Pressing  at an alarm display shows the name of the sensor and one of five icons representing the alarm type, as follows: 

 

ARB Display (representative) 

 

‘No Alarms’ Display 

 

AAAAAAAAAAAAAAAA Sensor Name 

 

Channel A (Temperature). Temperature value has gone beyond pre-set High (or Low) thresholds. 

 

Channel B (Humidity) Humidity value has gone beyond pre-set High (or Low) levels.  

  
Door Open. Storage facility door has been left open for more that the pre-set threshold. 

 
Elapsed Time Warning. A signal has not been received from the sensor for more than the pre-set limit. 

 
Battery state alarm. Battery should be replaced. 

 

 Pressing  on any screen shows Channel A alarm details. 
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 Pressing  on display of on the  ACKNOWLEDGE screen acknowledges the alarm. also indicates a successful download of data from 

an MM7000 unit (see above). 

 Pressing  on the Channel A, Channel B or RETURN screens goes back to the starting screen. 

2.4.4 Example Sub-Screens 

Dual Ext Therm 106  Single PT100 

Temperature   22.4C  Temperature   22.7C 

Channel 2  22.5C  Channel 2  

 

Here,  indicates High alarm,  indicates Low alarm,  = rate of change alarm. 

In the first of above examples, the transmitter is called ‘Dual Ext Therm 106’, has two alarms for temperature (‘High’ might be ‘High High’) on channel 2 and a 
rate of change alarm. 

The second example (‘Single PT100’) has a High (or High High) alarm on channel 1. 

 

 



System Manual 

The Notion Pro Hardware 

 

 

 

 
IM5521-1 Page 20 of 174  

 

2.5 The Calibration Module (Optional) 

 

The Calibration Module collects data from the Notion Pro Calibration Tool (part of the Notion Pro software) and transfers the data to transmitters placed in the 
cradle via RFID. Licence to use the device will expire annually. 

 IMC Part No IN-CM01. 

 Green LED for power (normal state on). 

 Mains powered from supplied adaptor. 

 IP53 rated. 

2.5.1 Connectors 

 

See also section 2.1.2. 

2.5.2 Display 

Alarm display. Used to show failed communications. 

Cradle 
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2.5.3 Operation 

Would usually be held by a Calibration Engineer, who would come in to the customer’s premises on request. Would be used flat on a table connected by 
RS485 cable to the Engineer’s laptop.  

The Calibration Tool interacts with the Calibration Module and acts as a virtual display and keyboard.  When a transmitter is to be calibrated it must be placed 
on the Calibration Module cradle. The Engineer then puts the Calibration Module into calibration mode via the calibration tool software. 

When a Transmitter is put into calibration mode it sends messages to the System to identify that it is in calibration mode to stop alarms. When the transmitter 
is taken out of calibration mode another message is sent to the System that it is back in normal mode.  If the sensor for some reason has not been taken out 
of calibration mode in 6 hours then an alarm is sent to warn that the transmitter is still in calibration mode. 

Once the unit has gone through its calibration routine the Engineer will take it out of calibration mode.  All calibration details will be held in the Transmitter 
itself, so no adjustments to the Notion Pro data base are required. 
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2.6 The Transmitters 

 

All the members of the Notion Pro Transmitter family have the same basic enclosure (see above) and share many common characteristics. The available 
sensors can monitor temperature and relative humidity, voltage and 4-20mA current, (intended to interface with third party sensors), as well as providing door 

alarms. There are also external PT100 and thermocouple sensor probe options. For more detail on the Notion Pro transmitter family, see the data sheets at 
http://www.the-imcgroup.com/notionpro/. 

All transmitters can be wall-mounted or free standing, as required. As far as possible, the transmitter units should be placed where they will not be subject to 
electromagnetic interference and where they will not be shielded by walls, doors, metal furniture, appliances etc. Note that if you have more than one Network 
Receiver on your Site and the signal from a given transmitter is being picked up by more than one Receiver, you can associate the transmitter with the 
Receiver unit which is showing the highest signal strength for that transmitter. See section 2.7.7 in Part 2 of this manual. 

 All units can operate within a -30°C to +50°C temperature range. 

 All units have user-replaceable 1.5V Lithium AA batteries. These have an expected life of  >2years and work over -30°C to +50°C temperature range. 1.5V 
AA alkaline can be used but with a reduced battery life and a reduced operating temperature range (0°C to +40°C). 
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2.6.1 Air Temperature, Internal 

 

 

 IMC Product Code IN-TH001-Fx 

 Product Family: NP3000 series 

 Accuracy ±0.5°C, 0.1°C resolution.  

 Transmits data once per minute. 

 Battery level status and alarms. 

 Calibration options are return to IMC, or on site by trained Engineer. 

 Gap filling protocol via ARB Module with RFID interface. 

 Green Status LED for commissioning and fault finding. 

 IP65 rated. 

 Approvals – see Section 5. 
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2.6.2 Air Temperature,  Internal + Door Switch 

 

 

 IMC Product Code IN-THD01-Fx 

 Product Family: NP3000 series 

 As 2.6.1 but with door monitoring and alarm function. 

 External sensor range -30°C to +50°C.  
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2.6.3 Single Channel, External Temperature Probe 

 

 IMC Product Code IN-TH002-Fx 

 Product Family: NP3000 series 

 As 2.6.1 but internal sensor is replaced by an external sensor connected 
via a waterproof connector. 

 External sensor range -40°C to +70°C. 

2.6.4 Single Channel, External Temperature Probe + Door Switch 

 

 IMC Product Code IN-THD02-Fx 

 Product Family: NP3000 series 

 As 2.6.1 but internal sensor is replaced with two external sensors 
connected via a waterproof connector. 

 External sensor range -40°C to +70°C. 

 Dual Channel Internal and External 

2.6.5 Dual Channel,  Internal and External Temperature Probe 

 

 IMC Product Code IN-TH003-Fx 

 Product Family: NP3000 series 

 As at 2.6.1 with the addition of external sensor channel connected via a 
waterproof connector. 

 External sensor range -40° to +70°C 

 No door monitoring and alarm function. 

2.6.6 Dual Channel, External Thermistor 

 

 IMC Product Code IN-TH004-Fx 

 Product Family: NP3000 series 

 As at 2.6.3 with the addition of a second external sensor channel. 

 Sensor range -40° to +70°C. 
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2.6.7 Single Channel, External PT100 Probe 

 

 IMC Product Code IN-PT001-Fx 

 Product Family: NP3100 series 

 As at 2.6.1 with the internal thermistor being replaced by a single 
external 4-wire Class A PT100 probe. Used to measure temperature at a 
specific point, typically inside a freezer. This unit can withstand a much 
wider temperature range that an internal thermistor. 

 Range -100°C to +200°C 

 Resolution 0.1°C 

 Accuracy ± 0.1°C calibrated 

 PT100 Probe Class A accuracy un-calibrated 

 Probe connection via a waterproof connector. 

2.6.8 Single Channel, External PT100 Probe + Door Switch 

 

 IMC Product Code IN-PTD01-Fx 

 Product Family: NP3100 series 

 As at 2.6.7 but with a door monitoring and alarm function. 

2.6.9 Dual Channel, External PT100 Probe 

 

 IMC Product Code IN-PT002-Fx 

 Product Family: NP3100 series 

 Dual Hirose base connector 

 As 2.6.7 but with a second external PT100 channel. 
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2.6.10 Single Channel, Type T Thermocouple 

 

 IMC Product Code IN-TT001-Fx 

 Product Family: NP3200 series 

 Single thermocouple base connector 

 As at 2.6.1 with the internal thermistor being replaced by a single Type T 
thermocouple. 

 Range -200°C to +350°C 

 Resolution 0.3°C 

 Accuracy ± 0.5°C. 

 IP53 

2.6.11 Dual Channel Type T Thermocouple 

 

 IMC Product Code. IN-TT002-Fx 

 Product Family: NP3200 series 

 Dual thermocouple base connector 

 As 2.6.10 with the addition of a second external Type T thermocouple 
channel. 

2.6.12 Single Channel Type T Thermocouple + Door Switch 

  

 IMC Product Code IN-TTD01-Fx 

 Product Family: NP3200 series 

 Single thermocouple base connector 

 As at 2.6.10 with a door monitoring and alarm function. 

 Range -200°C to +350°C 

 Resolution 0.3°C 

 Accuracy ± 0.5°C.  

 IP53 

2.6.13 Dual Channel 4-20mA Input 

 

 IMC Product Code IN-MA001-Fx 

 As 2.6.1 with the internal thermistor being replaced with two current 
channels. 

 Input 4-20mA. 
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2.6.14 Dual Channel, Voltage Input Transmitter 

 

 IMC Product Codes IN-VT001-Fx, IN-VT002-Fx, IN-VT003-Fx 

 As 2.6.2 with the internal thermistor being replaced with two voltage 
channels. 

2.6.15 Temperature and RH transmitter 

 

 IMC Product Code IN-RH001-Fx 

 As 2.6.2 using the internal thermistor. 

 Sensor type: Sensirion type SHT75. 

 RH range 10-90%. 

 Resolution 0.1%. 

 Accuracy ±3%. 

 Sensor mounted in external housing fixed to case. 
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3 Base Unit Installation Procedure (typical) 

Note: This procedure takes you through the generic setup steps for physically setting up the members of the Notion Pro Base Unit family, that is: 

 Network Receiver 

 Echo Module 

 SMS Module 

 ARB Module 

Each of these units will be referred to as a ‘Base Unit’ in the following procedure. 

Install Step  Notes 

1. Using the mounting bracket as a drilling 
template, drill holes for the Base Unit wall 
mounting bracket into the wall at an 
appropriate location. 

2. Using the spacers provided to give 
clearance, Screw the mounting bracket to 
the wall. 

 

When mounting the Base Unit, you should 
bear in mind that you may need to run 
cables from the Base Unit to the 12V 
power supply, also Ethernet and RS485 
connections may be present. 

3. Using a Phillips screwdriver, remove and 
retain the screws from the battery cover 
plate at the rear of the Base Unit. 
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Install Step  Notes 

4. Insert the backup battery into the recess at 
the rear of the Base Unit, taking care to 
insert the connector attached to the battery 
into the matching connector within the 
Base Unit. 

  

5. Screw the battery cover plate to the rear of 
the Base Unit. 

  

6. Attach the Base Unit to the mounting 
bracket. 

  

7. Using the supplied RJ45 cable, connect 
the Base Unit to your Network. 

 (Echo Module communicates by radio and 
must NOT be connected to a Network.) 

8. Using the supplied cable, connect the 
Base Unit to its 12V power supply. 

  

 

9. Plug the power supply cable into the power 
supply unit. 

  

 

10. Slide the appropriate plug adaptor onto the 
power supply. 

 Do not connect the power supply to the 
mains supply yet. 

11. Plug in the Base Unit power supply to the 
mains supply and switch on at the mains 
socket. 

 A green light comes on. 

Power Supply works automatically with 
110V-120V or 220V-240V mains voltage. 

12. Go into Notion Pro to add Transmitters to 
Zones and configure them for use. 

 See the Notion Pro Help for details. 
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4 Adding Transmitters 

As far as possible, the transmitter units should be placed where they will not be subject to electromagnetic 
interference and where they will not be shielded by walls, doors, furniture, appliances etc. They should 
preferably be mounted vertically to maximise radio range. 

A wall-mounting bracket is available, IMC part no. N494. 

4.1 Transmitter Unit Replacement Batteries 

IMC recommends: 

 Lithium - Energizer Ultimate Lithium L91 IMC stock no. G301 

 Alkaline - Duracell ID1500-10     IMC stock no. 88705. 
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5 Compliance 

The Notion Pro equipment conforms to the following international standards: 

 Country-specific radio approval. 

 R&TTE approval. See the IMC Group R&TTE Declaration of Conformity at 

http://www.the-imcgroup.com/images/Declarations/IceSpy/IceSpy-Notion-Pro-RTTE-DOC.pdf  

covering Radio and Telecommunications Terminal Equipment. 

 All Notion Pro hardware carries the  mark to indicate that the equipment meets the requirements of the 
applicable EC Directives. 

 WEEE compliance. 

 RoHS compliance. 

 Conflict minerals. 

 Reach.

http://www.the-imcgroup.com/images/Declarations/IceSpy/IceSpy-Notion-Pro-RTTE-DOC.pdf
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NOTE 

If you are NOT a System Administrator, go to Section 4 to read about how to use Notion Pro to monitor 
data from the sensors on your Site. You will be unable to access the facilities detailed in Sections 1-3. 

1 First Time Login (System Administrator) 

To view the Notion Pro website, you will need to open a browser and navigate to the Notion Pro site.  

If you are working on the Notion Pro Server itself, enter http://localhost/NotionPro in the browser’s address field. 

If you are working on a another computer or device, you will need to use the URL supplied by your System 
Administrator or IT Support provider to reach the Notion Pro server. This may be similar to 
ServerName/NotionPro for a LAN connection or www.mycompany.com/NotionPro for an internet connection. 

 

Figure 1 

Once you have navigated to the correct URL, the login screen will be displayed, as in Figure 1above. 

As you are setting up the system immediately after installation, you need to login as the system Administration 
User:  

Username: Admin User 

Password: Admin 

Enter your username and password to login, then click Sign In Passwords are case sensitive. 
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As this is the first time you have logged in, you must supply the answer to a security question, so if you forget 
your password in the future, you can retrieve it using a procedure which includes supplying the answer to your 
security question. See Figure 2. 

 

 

Figure 2 

Choose your security question by clicking  and choosing from the list. Type the answer into the box below, 
then click Submit. 

You will now be returned to the login screen see Figure 1, where you will again need to enter your username 
and password. 

The Security Question screen is only shown when a user logs in for the first time; it will not show when you 
login as the Admin User again. 

Note: When you get to section 2.1.7 below, you should change the default Admin User password so that it is 
secure. 
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2 Setting Up Users, Sites and Devices 

This Section will guide you through the setting up of Users, User Groups, Access control, System 
Configuration, Sites, Device Configuration, Account settings, System Overview and Sensor Groups. 

Note: The functionality described in this Section only applies to System Administrators or Users who have 
been given System Administrator access rights. The Admin User is created automatically when Notion 
Pro is installed. The Admin User cannot be deleted. 

When you get to section 2.1.7 below, you should change the default Admin User password to something more 
secure, which is memorable. 

2.1 User Management 

User Management allows you to add Users, edit Users, add External Contacts and edit External Contacts.  

2.1.1 Adding and Editing Users 

 

Select Admin then User Management from the drop down menu to 
access the User Management section.  

The Admin menu is located at the right hand side of the top menu bar. 

After selecting User Management a new window appears see Figure 4 
below. 

 

Figure 3 

 

Figure 4 
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2.1.2 Add User Name 

In the dialog box above (Figure 4) enter a new User Name. If the user name is already taken the following 
message will be displayed. 

 

Select another User Name until the following message is displayed: 

 

2.1.3 Add Password 

Enter a password into the Password field, now re-enter your password into the Confirm Password field. It is 
not recommended to cut and paste the password as this would copy a mistake to the Confirm Password field. 
If when typing your password into the Confirm Password field you make a mistake, the following message will 
be displayed. 

 

If you have re-typed your password correctly then you will be able to proceed to the next step. 

By default, Notion Pro requires passwords to be at least eight characters long. The Administrator will not be 
able to set a minimum password length of less than eight characters. This is configurable by the Administrator. 
The User ID and password cannot be the same. 

Administrators may also require that user passwords have an alphanumeric and mixed case. In this case, 
passwords must have numeric characters, upper and lower case letters. 

2.1.4 Password Never Expires 

By default user passwords are set to expire in 90 days, this is selectable by the Administrator. 

Password Expiry does NOT apply to the Admin User password, which is always set to never expire. 

2.1.5 Email: 

This field allows you to enter your email address. This is used to receive the following: 

 email alerts generated from the system 

 email reports. 

 password reminders. 

2.1.6 Telephone No: 

This field allows you to enter your mobile phone number. This is used to receive SMS text alerts generated 
from the system. 

The number should be entered in the following format: 

+44 123 987654 
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2.1.7 Edit/View Users 

Edit/View Users allows you to edit existing user’s details. The following functions are available: 

 Edit allows passwords to be changed along with email address and phone number 

 Delete allows single or multiple users to be deleted  

 Privileges allows users to be set with viewing rights. 

 

To edit new user, select Edit/View Users 

After selecting Edit/View Users a new window opens (see Figure 6). 

 

Figure 5 

 

Figure 6 

2.1.7.1 Edit 

To edit a user select Edit. After selecting Edit a new window opens (see Figure 7). 
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Figure 7 

Here you can change the User’s email address and mobile phone number. If you wish to update the User 
without changing your password tick Keep Old Password and the existing password will be populated in the 
password dialog boxes. If you wish to change your password follow steps in 2.1.3. 

2.1.7.2 Reset Lockout 

Locked out users can be reset from this screen, by selecting Reset Lockout. 

When you are happy that all details are correct, click the Update User button. 

2.1.7.3 Delete User 

There are three methods for deleting users: 

1. Select Delete (see Figure 6). This will delete the record selected, once you are happy with your selection 
confirm delete by selecting YES on the warning dialog box (see Figure 8). 

 

Figure 8 

2. If more than one user is to be deleted select the tick box to the left of the name, tick all users to be deleted 
(see Figure 6). Once you are happy with your selections click Delete Users (see Figure 6) select confirm 
delete by selecting YES on the warning dialog box (see Figure 8). 

3. By clicking the tick box next to User Name all users will be deleted. WARNING, this will select all users for 
deletion (see Figure 6). Once you are absolutely sure you want to delete all users click Delete Users (see 
Figure 6) select confirm delete by selecting YES on the warning dialog box (see Figure 8). 

 

WARNING: Deleting users cannot be undone. 
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2.1.7.4 User Privileges 

This allows individual users to be assigned viewing rights to Sites and Zones. (See section 2.5 for more 
information on Sites and Zones.) Click on Privileges in the View User window (see Figure 6) for the User that 
you wish to assign viewing rights to. This gives the Assign Privileges dialogue box (see Figure 9). 

 

Figure 9 

In the example above, User1 has been pre-allocated with viewing access to the Notion Pro Demo Site and the 
listed Zones. Click Assign Site Access or Remove Site Access as required. See also section 2.2.4. 
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2.1.8 Create External Contacts 

External contacts are used when there is a requirement to email reports or send SMS alarms to people who are 
not Notion Pro users. 

 

To create external contacts, select Create External Contact. 

After selecting Create External Contact a new window opens, see 
Figure 11 below. 

Figure 10 

 

Figure 11 

Enter User Name, Email and Telephone No as in Part 2, section 2.1.2 for an external user. There is no 
requirement for a password as these users do not have access to Notion Pro. 

2.1.9 Edit/View External Contacts 

 

To Edit/View external contacts, select Edit/View External Contacts. 

After selecting Edit/View External Contacts a new window opens (see 
Figure 13) 

 

Figure 12 

 

Figure 13 

To edit external user details follow steps in section 2.1.7.1, to delete external users follow the steps in section 
2.1.7.3. 
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2.1.10 Password Security Settings 

 

To Edit/View Password Security Settings, select Password Security 
Settings. Once selected, the Password Security Settings window will be 
shown see Figure 14 below. 

 

 

 

Figure 14 

The Password Security Settings window is used to set the system’s login security features. Login security 
features apply globally to all logins, with some exceptions for the Admin User account, as detailed below.  

Individual features can be disabled by selecting the associated Feature Off tick box. Clicking Apply Default 
will return Password Security features to the default settings. click Update to apply any changes made. 
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2.1.10.1 Auto Logout Period (Mins) 

If a login session is left unattended, then the system will log the user off after the Auto Logout period. The auto 
logout period can be set by the Administrator. 

When Auto Logout activates, the browser will continue showing the last screen actioned by the user, and if on 
the Live View, data values will continue to update on the screen. However, when the user tries change window 
or enter a value, then the browser will show the Login screen and require the user to log back into the system. 

The Auto Logout Period can be set between 5 and 60 minutes, the default period is 30 minutes.  

2.1.10.2 Password Expiry 

Passwords will automatically expire, and need to be changed, after the Password Expiry time. By default user 
passwords are set to expire in 90 days, this is selectable by the Administrator. Password Expiry does NOT 
apply to the Admin User password, which is always set to never expire. 

Users are warned on login within 10 days of expiry, and given the option to type in a new password. This can 
be done any time between the first warning and expiry. The warning time is settable by the Administrator. This 
will be a countdown warning and will decrease as the expiry deadline approaches. 

Once a password has expired no further access will be allowed for that user until they enter their expired 
password at which point the system will force a change before any further progress can be made. 

2.1.10.3 Password Depth 

The Password Depth sets the number of previous passwords that cannot be immediately reused by a user. A 
password depth can be set globally, between 1 and 10. 

2.1.10.4 Retries Allowed 

This is the number of failed login attempts allowed for a username, within the Retries Period, before the user is 
locked out. Locked out users are informed of their locked out status, when they try to login. 

Lockout Period is the time that a user will be locked out after the Retries limit is exceeded. 

By default users will be locked out for 60 minutes after three consecutive failed password login attempts within 
a 30 minute period. Where a lockout occurs, the user will be informed of the lockout period by a message on 
the browser, and the lockout will be recorded in the activity log. 

The number of Retries Allowed can be up to 10. The Lockout Period can be up to 1440 minutes and the Retries 
Period can be between 10 and 1440 minutes. The Admin User is never locked out. 

A lockout value of 0 will lock out users until reset by the Administrator. Any Administrator lockout will be for 30 
minutes, (this prevents the Administrator becoming permanently locked out). 

A Reset Lockout tick box is available on the User Details screen. This control will normally be greyed out, and 
will only become active when the user is currently locked out. This control is only accessible by an 
Administrator. Administrators can reset a locked out user from the Edit/View Users window, see section 
2.1.7.1. 

2.1.10.5 Username Reuse 

Deleted usernames cannot be reused for the period of time specified by Username Reuse. If an Administrator 
types a Reuse blocked username into the User Details screen, a warning will be displayed. By default, 
Username Reuse checking is disabled. 

2.1.10.6 Minimum Password Length 

By default, Notion Pro will require passwords to be at least four characters long, the Administrator will not be 
able to set a password length of less than four characters. This is configurable by the Administrator. The User 
ID and password cannot be the same. 
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2.1.10.7 Accepted Value Ranges  

The list below details the setting ranges for each option: 

Auto Logout – 5 to 60 minutes. 

Password Expiry – 30 to 730 days. 

Retries Allowed – 1 to 10 attempts. 

Lockout Period – 0 to 1440 minutes; 0 will lockout users until reset by the Administrator. 

Retries Period – 10 to 1440 minutes. 

Password depth – 1 to 10. 

Minimum Password Length – 8 to 50 characters. 

Minimum Numbers, Minimum Letters, and Minimum Upper Case – 1 to 50, these values are consistency 
checked, against minimum length and each other. 

2.1.11 Changing the Password 

 

To change your password select Settings>Account Settings then 
Change Password to give the Change Password dialogue box. 
See Figure 15 below. 

 

 

Figure 15 

Enter the old password in the Old Password field. Enter the new password in the New Password field, enter it 
again in the Confirm New Password field. 

Note: It is recommended that a password be at least eight characters in length and contain at least one 
number, one letter, one uppercase letter. 

Click Submit. The message shown in Figure 16  below will be displayed to confirm a successful password 
reset.  
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Figure 16 

2.1.12 Changing your Security Question 

You will need to know the answer to your security question if you have forgotten your password and you have 
to click on the Forgotten password? Link on the Sign In screen. 

 

To change your security question select Settings>Account Settings 
then Change Security Question to give the Change Security 
Question dialogue box. See Figure 17 below. 

 

 

Figure 17 

Select your security question from the Security Question pull-down list, the enter the answer into the Answer 
field, then click Submit. Click Submit. The message shown in Figure 18  below will be displayed to confirm a 
successful password reset. 

 

Figure 18 
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2.2 User Group Management 

This section describes how User Groups are created and used. User Groups allow viewing Privileges to be 
set for a group, Users added to that group inherit the viewing Privileges associated with that group. Any 
previous viewing Privileges assigned to an individual user will be overridden by the viewing Privileges 
associated with that group.  

To learn about setting Privileges for individual users see section 2.2.4. Privileges are the viewing rights that 
allow a user to see Sites and Zones. Through Privileges a user can be restricted to the number of Zones they 
can see. This is especially useful on very large systems. 

 

Select Admin>User Group Management from the drop down menu to 
access the User Group Management section.  

After selecting User Group Management a new window appears, see 
Figure 19 below. 
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2.2.1 Create User Groups 

 

Figure 19 

To create a User Group, enter a name for the User Group, see examples below: 

 T+RH Sensors - for a small Site this could be used to allow access to all of the temperature and humidity 
sensors.  

 T+RH Sensors 1st Floor - for a larger site this could be used to allow access to all of the temperature and 
humidity sensors on one floor. 

Select the Users that you would like to add to the group. All users that have not already been associated with a 
group will be shown in the left column. To select more than one user hold the Ctrl key and select the required 
users. Once you are happy with the selected users click the double left arrows located between the columns, 
this will move the users to the right column. 

Users can be de-selected by selecting them in the right column and clicking the double left arrows. When you 
are happy with your selection, click on Add Members. You will be asked if you would like to proceed, see 
Figure 20 below. 

 

Figure 20 

Select YES to proceed or NO to abort. 
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2.2.2 Delete User Group 

 

To Delete a User Group select Delete in the line corresponding to the User Group to be deleted. Once Delete 
has been selected you will be asked if you would like to proceed, see Figure 21 below. 

 

Figure 21 

Select YES to proceed or NO to cancel. 

2.2.3 Edit User Group 

To Edit a User Group select Edit in the line corresponding to the User Group to be edited. Once Edit has been 
selected the Edit User Groups window will appear, see Figure 22 below. 

 

Figure 22 
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Users can be removed from the User Group or added. To remove Users highlight them in the right column and 
click the double left arrows. To add Users highlight them in the left column and click the double right arrows.  

When happy with your selections click Update Members. You cannot remove all the members from a group 
you must always have to have at least one member. If you want to remove all the members then the User 
Group needs to be deleted. 

When a User is removed from a User Group that User will require Privileges adding, see section 2.1.8 to add 
Privileges. 

2.2.4 User Group Privileges 

To set the Privileges for a User Group select Privileges in the line corresponding to the User Group to be 
edited. Once Privileges has been selected the Assign Privileges window will appear, see Figure 23 below. 

 

Figure 23 
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All Sites that have been added to Notion Pro will be visible in the Assign Privileges window. Sites with an 
empty tick box are top level Sites with no Sub Sites associated. Sites with a + symbol have Sub-Sites 
associated, see IMC Group Ltd above. 

Selecting the + symbol will reveal the Sub Site details, see Figure 24 

below. 

 

Figure 24 

To allow the members of User Group T + RH sensors 1st floor to view the sensors from the IMC Group 
Pendle House subsite select the tick box next to Pendle House. This will now allow all Users added to this 
group to be able to see those sensors only. 

When you are happy with your selections click on Assign Site Access, see Figure 25 below. 

 

Figure 25 

To remove access the process is the reverse of the above. When happy with your selections click on Remove 
Site Access. 

Some sites will have more Zones and sensor types than others. However, the process for allocating Privileges 
is the same. Depending on what the System Administrator want an individual user to see as many or as few 
sensors or Zones can be selected. 
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2.3 Access Control 

This section describes how users are granted permissions. Permissions are system access rights such as 
Edit, Delete etc. 

Notion Pro allows the creation of Roles which are assigned with access permissions. Users are added to Roles 
and inherit the permissions assigned to the Role thus avoiding the repetitious and error prone task of adding 
multiple individual users. 

 

Select Admin then Access Control from the drop down menu to access the 
Access Control section.  

After selecting Access Control a new window appears, see Figure 27 below.  

 

Figure 26 

2.3.1 Permissions Overview 

 

Figure 27 

The menu on the right above gives access to the different sections of Access Control, the list on the left above 
is the Permissions Overview for the Admin User. 

Note: the Permissions Overview list is much longer than the lists shown in this section, but these are 
abbreviated here for space reasons. 

The Admin User is created automatically when Notion Pro is installed. The Admin User cannot be deleted or 
the Permissions altered. 

As Users are added to the system they will automatically appear at the bottom of the Permissions Overview 
screen, see Figure 28 below. 
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Figure 28 

To view the Permissions granted to a user click on the underlined user name. The Permissions Overview for 
Customer window will appear see Figure 29 below. 

 

Figure 29 

A red circle with a cross means that the Permission is denied, a green circle with a tick means that the 
Permission is granted. These permissions are inherited from the Role that the user has been assigned; this 
process is described in section 2.3.2. 

2.3.2 Manage Roles 

Before you can assign Permissions to a user you need to create Roles. To view Roles click on Manage Roles. 
The Select a Role to Manage window will appear see Figure 30 below. 

 

Figure 30 

When Notion Pro is installed there are no pre-defined Roles set, the Admin User can create Roles and decide 
what Permissions to assign to each Role. The list below shows a typical set of Roles. There is no limit to the 
amount of Roles that can be set. 
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 Administrator  

 This would be a high level Role with all Permissions assigned.  

 Advanced User 
These would be a trusted users with access to Admin functions blocked but still able to edit sensor 
properties. Full data viewing and alarm acknowledging allowed. 

 General User 
These would be a lower level users with access to Admin functions and sensor editing blocked. Full data 
viewing is allowed. 

 Guest User 

 These would be a view-only user with no editing or alarm acknowledging rights. Full data viewing is allowed. 

See also Section 2.3.4. 

When Notion Pro is installed a default Admin User is created, the Admin User cannot be deleted and is preset 
with the Username “Admin User” and the Password “Admin”. We recommend that these details are changed 
immediately after installation. This can be done in Admin>User Management see section 2.1.3. The Admin 
User is pre-assigned with all available Permissions. 

When setting up from first install, select Admin>Access Control>Manage Roles. The Select a Role to 
Manage window appears, see Figure 31 below. 

 

Figure 31 

Click on New Role. The New Role window appears see Figure 32 below. 
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Figure 32 

Enter a name for Role. We would recommend using Administrator for the highest level user. It is also 
suggested that all functions are set to Allow with the exception of Activate privileged Access which should be 
set to Deny. Select Save. You have now created the Administrator Role. See Figure 33 below. 
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Figure 33 

Other Roles can be created as required following the instructions above. 



System Manual 

Setting Up Users, Sites and Devices 

 

 

 

 
IM5521-1 Page 56 of 174  

 

2.3.3 Permission Definitions 

Permission Description 
User 

Level 

Access Archive Database Controls access to Archived read only data M 

Access Control Controls access to the Access Control section H 

Access Logs Controls access to System Logs M 

Access Reports Controls access to Reports M 

Access Reports - Sensor Groups Controls access to Sensor Group Reports menu M 

Access Settings Controls access to entire Settings menu H 

Access Sites Controls access to Sites Section M 

Acknowledging Alarms Allows user to acknowledge alarms M 

Acknowledge Alarms in Bulk Allows user to acknowledge multiple sensors alarms H 

Activate privileged Access Allows Admin User to login as the user; See note 1 H 

Change Alarm Settings on Reset Allows user change alarm values, when resetting an Alarm M 

Device Configuration Controls access to the Device Configuration section H 

Disable User Allows user to disable other users. H 

Edit View Controls access to Edit View section M 

Email Alert Group Controls access to Email Alert Group section M 

Live View Controls access to Live View section; see note 2 L 

Live View - Sensor Groups Controls access to Sensor Groups L 

Password Security Settings Allows access to Password Security Settings screen H 

Plan View Controls access to Plan View section; see note 2 L 

Plan View Edit Allows movement of sensors in Plan View M 

SMS Alert Group Controls access to SMS Alert Group section M 

System Configuration Controls access to System Configuration section H 

User Group Management Controls access to User Group Management section H 

User Management Controls access to User Management section H 

 

Key: 

 H These permissions are recommended for the highest level user only 

 M These permissions can be granted to general users 

 L These permissions can be granted to all users 

Notes: 

1. So the Admin User can configure settings which the normal user does not have access too. 

2. This should be available to all users. 
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2.3.4 Suggested Role Definitions 

The following table gives suggested roles and the settings for those roles. You may wish to define roles and 
permissions slightly differently for your Site. 

Role Permissions 

General Administrator Select Ignore for: 

 Access Control 

 Access Logs 

 Access Sites 

 Activate privileged Access 

 Disable User 

 User Group Management 

 User Management 

Select the Allow option buttons for all other permissions. 

Advanced User Select Ignore for: 

 Access Control 

 Access Logs 

 Access Sites 

 Activate privileged Access 

 Change Alarm Settings on Reset 

 Device Configuration 

 Disable User 

 User Group Management 

 User Management 

Select the Allow option buttons for all other permissions. 

Standard User Select Ignore for: 

 Access Reports 

 Access Reports – Sensor Groups 

 Access Settings 

 Acknowledge Alarms 

 Bulk Acknowledge Alarms 

 Live View 

 Live View – Sensor Groups 

 Plan View 

Select the Deny option buttons for all other permissions. 

Guest User Select Ignore for: 

 Live View 

 Live View – Sensor Groups 

 Plan View 

Select the Deny option buttons for all other permissions. 



System Manual 

Setting Up Users, Sites and Devices 

 

 

 

 
IM5521-1 Page 58 of 174  

 

2.3.5 Manage Users 

Notion Pro allows users to be associated with Roles rather than having to individually add Permissions to 
each individual User. Permissions can also be done individually if required. 

When setting up users, select Admin>Access Control>Manage Users. The Select a User to Manage 
window appears. See Figure 34 below. 

 

Figure 34 

To assign a User to a Role click on Select next to the user name that you want to assign a Role to, see Figure 
34 above. The Managing User window appears, see Figure 35 below. 

 

Figure 35 

To assign a Role to this User select Manage Roles. The Manage User Roles window appears. See Figure 36 
below. 

 

Figure 36 

In this case the previously selected User was the Administrator user so we need to select the Member option 
button next to Administrator to put this user into the Administrator Role. This user will now inherit the 
Permissions assigned to this Role. More than one user can be assigned to the same Role. 

A user can be assigned to more than one Role for example a lower level user can be assigned a higher set of 
Permissions by an Admin user on a temporary basis. This allows a user to stand in for a colleague without the 
need to access the user settings and individually change the Permissions.  
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2.3.6 User Permissions 

The main method for Notion Pro users to be granted Permissions is by association to a Role. For total flexibility 
an individual user can have some permissions Allowed or Denied rather than Inherited.   

To manage Permissions for a User: 

1. Select Manage Users to give the Select a User to Manage dialogue box. 

2. Select the required user to give the Managing <user name> dialogue box. 

3. Click Manage Permissions to give the Manage User Permissions window. See Figure 37 below. 

 

Figure 37 

To change Permission select the drop down arrow next to the Permission to be changed and select either 
Allow or Deny. The above process can be repeated for other Users and Roles. 
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2.4 System Configuration 

This section is where the email and SMS settings are set for the automated alarm functions. 

 

Select Admin then System Configuration from the drop down menu to access 
the System Configuration section.  

 

After selecting System Configuration a new window appears, see Figure 39 
below. 

 

Figure 38 

2.4.1 Email Alert Global Settings 

 

Figure 39 
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The details in the above example ideally should have been collected prior to installation and if available will be 
on the Notion Pro Pre-Requisites form. If the details are not available at the time of commissioning, you will 
need to contact your IT department or provider. If the details are available enter them into the dialog boxes 
above.  

It is not essential that these details are entered at this time. If email alerts and emailed reports are not required 
at this point these details can be entered at a later date. 

Mail Servers can be specified as a resolvable hostname or IPv4 address. The example settings, shown in 
Figure 39 above, will use standard IANA assigned port numbers when connecting to the mail server(s). If 
required you can specify the port number to be used, by adding a colon ‘:’ followed by the required port number 
to the server hostname or IPv4 address; e.g. ‘MS001:25’ would use port 25. 

If you do not know the address(s) and/or port number(s) used by your Mail server, contact your system 
administrator or IT support provider; please do NOT contact IMC Technical Support, as this is information that 
only your IT administrator or support provider can supply. 

It is recommended that the Heartbeat message is enabled, the problem with automated alarm systems using 
tools such as email, is if you don’t get an alarm for several days or weeks then it is difficult to know if that is 
because the system is not generating any alarms or is it because the email system has failed. The Heartbeat 
message will give a daily indication that everything is functioning correctly. The timing of the Heartbeat 
message can be set in the bottom dialog box, please ensure that the time is entered in the following format: 

 14:15:00 

Any time from the 24 hour clock can be set. When all settings are entered select Update. 

The Receive Email and IMAP/POP3 settings are for email alert acknowledgement handling, and can be left 
blank should this feature not be required. 

Note: Do NOT set the BCC Email Address to be the same as the Sender Email Address.  

Warning: It is not recommended that email alerts are used on their own for critical alarms. Email alerts rely on 
your internal email systems functioning correctly. Or if your Internet Service Provider is suffering any problems 
this will also cause disruption of service. 

For critical alarms IMC recommend the use of two different methods to send out alarm alerts. 

Other forms of alarm alert generation methods are SMS driven from the SMS Module GSM device or hard 
wired relays driven locally from the Network Receivers. Both methods require extra hardware. 

Contact your sales representative or your local distributor for further details. Contact information can be found 
on our website at http://www.the-imcgroup.com/contact-us for our UK Head office contacts or http://www.the-
imcgroup.com/global-distributors to contact one of our authorised distributors. 

2.4.2 SMS Alert Global Settings 

Notion Pro allows alarm alerts to be sent out via SMS Alerts. 

To set up SMS Alert Global Settings, select Admin>System Configuration> SMS Alert Global Settings. 
The SMS Alert Global Settings Window will appear, see Figure 40 below. 

 

Figure 40 

http://www.the-imcgroup.com/contact-us
http://www.the-imcgroup.com/global-distributors
http://www.the-imcgroup.com/global-distributors
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When using the SMS Module anywhere in Europe tick EU Phone Band, when using outside Europe leave EU 
Phone Band un-ticked. 

It is recommended that the Heartbeat message is enabled. The problem with automated alarm systems using 
tools such as SMS is, if you don’t get an alarm for several days or weeks then it is difficult to know if that is 
because the system is not generating any alarms or is it because the SMS system has failed. The Heartbeat 
message will give a daily indication that everything is functioning correctly. The timing of the Heartbeat 
message can be set in the bottom dialog box, please ensure that the time is entered in the following format: 

 10:10:00 

Any time from the 24 hour clock can be set. When all settings are entered select Update. 

2.4.3 Email Heartbeat Group 

You can create the Email Heartbeat Group which allows multiple users to be allocated to a group. To create 
the Email Heartbeat Group select Email Heartbeat Group from the side menu and the Create Email 
Heartbeat Group Window will appear see Figure 41 below. 

 

Figure 41 

Step 1 

Enter a name for the group in the dialog box next to Group Name, then enter a phrase in the dialog box next to 
Email Subject. The text entered here will become the subject of the email. 

Step 2  

Click on the Contacts tab and the Contacts dialog box appears, see Figure 42 below.  

 

Figure 42 

To add Contacts select Add Contacts and the Add Contacts window appears, see Figure 43 below. 
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Figure 43 

Select a Site from the Site Name drop-down menu on the dialog box. On initial setup there will only be one 
Site available which is created during the installation. See more about creating Sites in section 5.5.1. 

The selected Site’s associated contacts will appear in the left window, when the Site contacts/users list is long 
the required Contacts can be found by using the Filter. Select the right facing arrow to move the Contact to 
the right window. More than one Contact can be moved across. Once you are happy with your selection of 
Contacts select the Submit button at the bottom left. This will return you to the Create Email Heartbeat 
Group window; select the Update button to save the group. 

2.4.4 SMS Heartbeat Group 

You can create the SMS Heartbeat Group which allows multiple users to be allocated to a group. To create 
the SMS Heartbeat Group select SMS Heartbeat Group from the menu and the Create SMS Heartbeat 
Group window will appear see, Figure 44 below. 
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Figure 44 

Step 1 

Enter a name for the group in the dialog box next to Group Name. 

Step2 

Click on the tab marked Contacts and the Contacts dialog box appears, see Figure 45 below.  

 

Figure 45 

To add Contacts select the Add Contacts text and the Add Contacts window appears, see Figure 46 below. 
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Figure 46 

Select a Site using the drop down menu on the Site Name dialog box on initial setup there will only be one Site 
available which is created during the installation. See more about creating Sites in section 4.5. 

The selected Site’s Contacts will appear in the left window, when the Contact list is long the required Contact 
can be found by using the Filter. Select the right facing arrow to move the Contact to the right window. More 
than one Contact can be moved across. Once you are happy with your selection of Contacts select the 
Submit button at the bottom left. This will return you to the Create SMS Heartbeat Group window; select the 
Submit button to save the group. 

2.4.5 Email System Group 

You can create the Email System Group. The Email System Group sends email alerts from a predefined list 
of system events, these events are: 

 Edit 

 System Start 

 System Stop 

 Login Fail 

 Hardware Event 
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Multiple users can be allocated to the group. To create the Email System Group select Email System Group 
from the menu and the Create Email System Group window appears, see Figure 47 below. 

 

Figure 47 

Step 1 

Enter a name for the group in the dialog box next to Group Name, next enter a phrase in the dialog box next to 
Email Subject. The text entered here will become the subject of the email. 

Step 2 

Select the parameters from the System Events list that you require notification on. 

Step 3 

Click on the tab marked Contacts and the Contacts dialog box appears, see Figure 48 below.  

 

Figure 48 

To add Contacts select Add Contacts and the Add Contacts Window will appear, see Figure 49 below. 
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Figure 49 

Select a Site using the drop down menu on the Site Name dialog box on initial setup there will only be one Site 
available which is created during the installation. See more about creating Sites in section 4.5. 

The selected Site’s contacts will appear in the left window, when the Site contacts list is long the required 
Contact can be found by using the Filter. Select the right facing arrow to move the Contact to the right window. 
More than one Contact can be moved across. Once you are happy with your selection of Contacts select the 
Submit button at the bottom left. This will return you to the Create Email System Group window; select the 
Submit button to save the group. 

2.4.6 SMS System Group 

You can create the SMS System Group, which sends SMS alerts from a predefined list of System Events. 
These events are: 

 Edit 

 System Start 

 System Stop 

 Login Fail 

 Hardware Event 
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Multiple users can be allocated to a group. To create an SMS System Group select SMS System Group from 
the side menu and the Create SMS System Group window will appear, see Figure 50 below. 

 

Figure 50 
Step 1 

Enter a name for the group in the dialog box next to Group Name. 

Step 2 

Select the parameters from the System Events panel that you require notification on.  

Step 3 

Click on the Contacts tab and the Contacts dialog box appears. See Figure 51 below. 

 

Figure 51 

To add Contacts select Add Contacts and the Add Contacts window appears. See Figure 52 below. 
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Figure 52 

Select a Site using the drop down menu on the Site Name dialog box. On initial setup there will only be one 
Site available which is created during the installation. See more about creating Sites in section 4.5. 

The selected Site’s contacts will appear in the left window, when the Site contacts list is long the required 
Contact can be found by using the Filter. Select the right facing arrow to move the Contact to the right window. 
More than one Contact can be moved across. Once you are happy with your selection of Contacts select the 
Submit button at the bottom left. This will return you to the Create SMS System Group window. Select the 
Submit button to save the group. 

2.4.7 The Check Email Feature 

This can be used verify that the settings that have been set up in Email Alert Global Settings (see section  
2.4.1) function correctly and that you can receive an email from Notion Lite. 

Select Check Email Feature to give the Check Email Feature dialog box, see Figure 53 below. 
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Figure 53 

Enter your email address into the Receiver Email Address field then click Submit – you should receive an email 
from Notion Pro. 

2.5 User Alerts 

User Alerts provide automated Alarm notification delivered via Email or SMS or both. (The SMS Module, see 
Part 1, section 2.3) is required for SMS Alarms). A user must be a member of an Alert Group in order to 
receive messages specified when setting up the System Configuration (Section 2.4). 

This section will take you through the use and settings for Email alarms and SMS Alarms. To access the User 
Alert settings select User Alerts from the main menu, see Figure 54 below. 

 

Figure 54 

2.5.1 Email Alert Group 

To access the E-mail Alert Group settings select E-Mail Alert Group from the menu, see Figure 55 below. 

 

Figure 55 

After selecting E-mail Alert Group and Create Email Alert Group from the side menu the Create Email Alert 
Group window appears, see Figure 56 below. 
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Figure 56 

The window above allows Alert Groups to be created and configured for the automated notification of email 
Alarms. 

Step 1 

Input a Group Name. This can be something that makes sense to the Site in question or something related to 
the function. For this example we will call the group, “Service Email” this will be a Group that sends email 
Alarms to the Service Engineers. 

Step 2 

Enter a subject title for the Email into Email Subject. For this example we will call it “System Alarm on Notion 
Pro Site” this would then alert the engineer in the email subject that they were getting an email about an Alarm 
condition on that Site. 

Step 3 

Enter an Acknowledge Timeout. This is the time that the system will wait for an acknowledgement email. This 
should be entered in time format like this 12:00:00, this would be a 12 hour delay. 

Step 4 

Select the tick box next to Confirm Acknowledge if an acknowledgement email is required.  

Step 5 

Email Alerts can be sent in Round Robin mode. Round Robin mode is when email alerts are sent to the first 
name in the list. If there is no response within the time limit the system moves on to the next person in the list 
and so on until a response is received, or emails have been sent to everybody in the list. To activate Round 
Robin mode select the tick box next to Round Robin Enable. 

Step 6 

You can select the time period the system waits before sending the next email, this should be entered in the 
Round Robin Timeout field in time format like this: 00:15:00. This would be a 15 minute delay. 
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Step 7 

If required, a reply email can be sent which will reset the alarms. To activate this feature select the tick box next 
to Email Reset Alarm. 

Step 8 

Select the alarm parameters that Email Alerts are required for by clicking in the tick box next to the alarm 
condition within the Alarms panel. Multiple selections can be made. 

Step 9 

Select the Sensors that you require to be included in the Alert Group. Click on the Sensors tab. A new window 
will appear, see Figure 57 below. 

 

Figure 57 

To add sensors click the underlined Add Sensors link. A new window will appear, see Figure 58 below. 

To select a Sensor first select a Zone from the Zone 
Name drop down menu. 

As the Zone is selected the available sensors in that 
Zone will populate the left column (Source List). 

To select Sensors highlight the ones that you want 

to generate email alerts for then click . 

To deselect Sensors highlight them in the right 

column and click . 

To move all Sensors across click the double arrows. 

Once happy with you selection select Submit. 

 

Figure 58 

To add Contacts to the Group select the System Contacts tab, see Figure 59 below. 
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Figure 59 

Contacts are the people that you want alerting by email when any of the selected sensors are in Alarm. To add 
Contacts select Add Contacts. A new window will appear see Figure 60 below for example. 

 

Figure 60 

To select a Contact or Contacts highlight the required Contacts and select , to de-select a Contact highlight 

the Contact and select . 

When happy with the details select Submit. 

There is an option to have email Alarms sent to non-Notion Pro Users or External Contacts. See section 2.1.8. 

To select External Contacts click the External Contacts tab and follow the procedure above for adding System 
Contacts. 
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2.5.2 SMS Alert Group 

To access the SMS Alert Group settings select SMS Alert Group from the menu, see Figure 61 below. 

 

Figure 61 

After selecting SMS Alert Group the Create SMS Alert Group window appears, see Figure 62 below. 

 

Figure 62 

The window above allows SMS Alert User Groups to be created and configured for the automated notification 
of SMS Alarms. Note that you will also need to check that the SMS Global Settings (see section 2.4.2) are 
correct. 
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Step 1 

Input a Group Name. This can be something that makes sense to the Site in question or something related to 
the function. For, example we could call the group, “Service SMS”. This will be a group that sends SMS 
Alarms to the Service Engineers. 

Step 2 

Enter an Acknowledge Timeout. This is the time that the system will wait for an acknowledgement message 
before re-sending the message. This should be entered in time format like this: 00:10:00. This would be a 10 
minute delay. 

Step 3 

Select the tick box next to Confirm Acknowledge if an acknowledgement SMS message is required.  

Step 4 

SMS Alerts can be sent in Round Robin mode. Round Robin mode is when SMS Alerts are sent to the first 
name in the list. If there is no response within the time limit the system moves on to the next person in the list 
and so on until a response is received. To activate Round Robin mode select the tick box next to Round Robin 
Enable. 

Step 5 

You can select the time period the system waits before sending the next message, this should be entered in 
time format like this: 00:15:00. This would be a 15 minute delay. 

Step 6 

If you require, a Reply SMS can be sent which will reset the Alarms. To activate this feature select the tick box 
next to SMS Reset Alarm. 

Step 7 

The number of times the system will go around the Round Robin loop can be limited. To activate this feature 
enter the number of times the system should go round the loop in the Maximum Round Robins field.  

Step 8 

Select the Alarm parameters that Email Alerts are required for by clicking in the tick box next to the Alarm 
condition within the Alarms panel. Multiple selections can be made. 

Step 9 

For Channel Alarms, you may define your own text message, (this can be used to trigger events on a 3
rd

-party 
system with SMS receive capability).  

To set-up the required message select Enable and enter the required text in the text box. See Figure 63 below. 

 

Figure 63 

Step 10 

Select the Sensors that you require to be included in the Alert Group. To select sensors click on the Sensors 
tab. A new window will appear, see Figure 64 below. 
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Figure 64 

To add sensors click the Add Sensors link, a new window will appear, see Figure 65 below. 

 

To select a Sensor first select a Zone from the drop 
down menu.  

As the Zone is selected the available Sensors will 
populate the left column (Source List). 

To select sensors highlight the ones that you want to 

generate email alerts for then click . 

To deselect Sensors highlight them in the right 

column and then click  . 

To move all Sensors across click the double arrows. 

Once happy with you selection select Submit. 

See Figure 66 below for example. 

 

Figure 65 
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Figure 66 

To add Contacts to the Group select the System Contacts tab. A new window will appear, see Figure 67 
below. 
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Figure 67 

Contacts are the people that you want alerting by email when any of the selected Sensors are in Alarm. To 
add Contacts select Add Contacts. A new window will appear see Figure 68 below. 

 

Figure 68 

To select a Contact or Contacts highlight the required Contacts and select , to de-select a Contact highlight 

the Contact and click . When happy with the details select Submit. 

There is an option to have email Alarms sent to non-Notion Pro Users or External Contacts. To add External 
Contacts to the system see section 2.1.8. 

To select External Contacts follow the procedure above for adding System Contacts. 
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2.5.2.1 Set SMS Times 

You can set times of day within which SMS messages can be sent. Select Set SMS Times to give the Set SMS 
Times dialogue box. See Figure 69 below. 

 

Figure 69 

Select the required SMS Alert Group from the Select SMS Group Name pull-down menu. 

For each day of the week, select the required Start and End times for SMS messaging. If necessary, two Start 
and End time periods can be set within a single 24-hour period. 

Enter Start and End times as required, then click Submit. 
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2.6 Site Management 

Sites are the main access points to the system data, each Site represents a single physical Site where 
receiving devices such as Network Receivers are located along with measuring Sensors/Transmitters. 

Sites can also have Sub Sites associated with the main top level Site. A Sub Site is used where it is desirable 
to sub-divide a main Site, for example when there are large numbers of sensors on a Site or many 
departments. Sub Sites could also be floors in a building or departments. 

 

Figure 70 

When Sub Sites are used the View Data, User Alerts, Reports and Logs are not available from the top level 
Site. These functions are now available from the Sub Sites. See below for details of viewing Site data from the 
Available Sites dialogue box. 

2.6.1 Creating Sites 

 

Select Admin>Sites from the drop down menu to access the Sites section.  

After selecting Sites a new window appears (see Figure 72 below). 

 

Figure 71 

 

Figure 72 
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To add a Site complete the following: 

 Site Name: Enter a name for the Site. For example, this could be the name of the company. 

 Location: Enter the location. For example, this could be the town or city. (not mandatory) 

 Address: This would be the Site address. (not mandatory) 

 Post Code: This would be the Site post code. (not mandatory) 

 Time Zone: Set this to the time zone of the Site. (The value displayed by default is the time zone of  
 the host PC. It is important to set this correctly, as dates in the database are stored using  GMT.) 

When all details have been entered and are correct, click Add Site. 

2.6.2 Viewing Sites 

To View Sites select Edit/View Sites from the side menu. The Available Sites window appears. See Figure 
73 below.  

 

Figure 73 

Note: The Available Sites dialogue box here is for editing Sites and Sub Sites and is not same as the Available 
Sites dialogue box available from the System Overview selection. 

2.6.3 Editing Sites 

To edit a Site select Edit on the line corresponding to the Site you wish to edit. The Edit Site window appears, 
see Figure 74 below. 

 

Figure 74 

All Site details can be edited in this window. When all details are correct select Update to save details.  

2.6.4 Adding Sub Sites 

To add Sub Sites select Add Sub Site on the line corresponding to the Site you wish to add Sub Sites to. The 
Add Sub Site window appears, see Figure 75 below. 
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Figure 75 

Enter a name for the Sub Site into the Sub Site Name field. When all details are correct select Add Sub Site to 
save the details and add the Sub Site. To return to the main Sites menu select Edit/View Sites from the side 
menu. 

2.6.5 Deleting Sites 

To delete a Site you must first delete all Sub Sites if any exist. To check this select Edit/View Sub Sites, see 
section 2.6.2. If Sub Sites exist select Delete to delete the Sub Site, see Figure 76 below. 

 

Figure 76 

When you are happy that you are deleting the correct Sub Site click Delete and confirm the deletion, see 
Figure 77 below. 

 

Figure 77 

 

Figure 78 

After deleting all Sub Sites the main site can now be deleted. To delete the required Site select Delete against 
the Site to be deleted. 

When you are happy that you are deleting the correct Site select YES, see Figure 79 below. 
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Figure 79 

2.6.6 Viewing Sub Sites 

To View a Sub Site select View Sub Sites on the line corresponding to the Site you wish to view Sub Sites for. 
The Available Sub Sites of window appears, see Figure 80 below. 

 

Figure 80 

To Edit the Sub Site select Edit. Address details and images can be changed or added. When happy with any 
changes select Update. 

2.7 Device Configuration 

Warning: Changing settings in this section will impact on system function, please proceed with caution. If in 
doubt please contact your local supplier or IMC Support. 

This section is where Notion Pro Hardware Devices are setup and configured. 

 

Select Admin>Device Configuration from the drop down menu to access 
the Device Configuration section.  

After selecting Device Configuration a new window appears (see Figure 82 
below). 

 

Figure 81 
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Figure 82 

2.7.1 Setting up the Database Logger Service 

The DB Logger Service is the Service that passes data to the SQL database. The Listening Port Name and 
the Listening Port No are set automatically during installation. There is an option to change this information 
during installation but it is highly recommended that the default values are used. If there is a port conflict this 
should be noted on the Notion Pro Pre-Requisites Manual (doc. no. IM5546) 

2.7.2 Edit/View DB Service 

To Edit the Listening Port No select Edit/View DB Service from the menu. A new window View DB Logger 
Service Details will appear, see Figure 83 below. 

 

Figure 83 

It is possible at some time in the future that a new piece of software could be added to the server which causes 
a Port conflict. IMC would recommend that the new item be given a different Port number. If this is not possible 
then a new Port number can be allocated to the relevant Notion Pro Service. 

To Edit the Port number select Edit in the line corresponding to the Service you wish to change the Port 
number a new window Database Logger Service Details will appear, see Figure 84 below. 

 

Figure 84 

You will need to contact your IT department or IT service provider to get a new Port number. Once you have 
the new Port number enter it into the dialog box next to Listening Port No. Once you are happy with the 
details select Update Details. 

Warning: The Data Services will need to be re-started after changes are made; and all Receiver Units , 
Alarm Units and SMS Units will need to be reconfigured. 
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2.7.3 Adding Devices 

This section describes the addition of wireless receiving devices to Notion Pro. To add Devices to Notion Pro 
select Add Device from the side menu. The Control Device Details window appears, see Figure 85 below. 

 

Figure 85 

Control Device Name: 

This should to be related to Site and location to identify the Device this should be a unique name across all 
sites. Example: Network Receiver First Floor Building One. Enter required text into dialog box next to 
Control Device Name. 

Device Type: 

The Device Type is selected from a pre-defined list; select the Device Type from the drop down menu. There is 
a label on the back of all Receiving Devices that states the Device Type. 

Device Serial No: 

This can be found on a label on the back of the device. 

Elapsed Connection Alert 

An Alert is generated if the specified time period elapses without the selected device connecting to the IMC 
Remote Data service. An entry is recorded in the Activity Log (see section 7.1) and the icon in the Available 

Sites dialogue box (see Figure 70) changes to red ( ). If the Email System Group and/or the SMS System 
Group has Hardware Event selected, then an Email and/or SMS will be sent. 

Installation Site: 

The Installation Site can be selected from the drop-down menu. This list is automatically populated with Site 
names added in the Sites section (2.6.1). Select the Site name for the Site that you are adding the Device to. 

Installation Sub-Site: 

The Installation Sub-Site can be selected from the drop down menu. This list is automatically populated with 
Sub Site names added in the Sites section see 2.5. Select the Sub Site name for the Site to which you are 
adding the Device. 
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2.7.4 Edit/View Devices 

Select the items to Edit when happy with the changes select Update Details. 

2.7.5 Create Device Groups 

Base Units can receive data from a maximum of 200 transmitters; on systems with more than 200 transmitters, 
Device Groups enable specific sensors to be assigned to a Base Unit, or group of Base Units.  

On systems with fewer than 200 transmitters, all sensors are available to be received by all Base units. 
However, Base Units still need to be a member of a Device Group. 

If you are going to fewer than 200 transmitters and all your Base Units are in a single location such as a 
warehouse or a laboratory, then it is probably best to group all your Base Units in a single group.  

If you are going to exceed 200 transmitters then you will need to use multiple Device Groups; also if you have 
Base Units at separate physical locations, then using separate Device Groups can help you manage your 
system.  

To add a Device Group select Create Device Groups from the menu. A new window Create Device Group 
will appear, see Figure 86 below. 

 
Figure 86 
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The Group Name should be a name that easily identifies a Device Group, a Group that contains one or more 
Receiving Devices. Every receiving device must be in a Device Group, see examples below. 

The Device Type is selected from a drop down menu. Select the Device Type that corresponds to your Device. 
The name of the device type is clearly printed on the front of your device (Base Unit). 

Available Devices will be listed in the left column, to select a Device highlight it then click the double right 
arrows to move it across to the right column. 

Once you are happy that the details are correct select Add Members. 

2.7.6 Edit/View Device Groups 

To Edit/View Device Groups select Edit/View Device Groups from the menu to give the View Device 
Groups window, see Figure 87 below. 

 

Figure 87 

To Edit a Device Group select Edit in the line corresponding to the Group Name that you wish to Edit, a new 
window called Edit Device Group will appear, see Figure 88 below. 
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Figure 88 

To remove Devices from the Group highlight them in the right hand column then select . The double left 

arrows will de-select them and move them to the left column. You cannot de-select all Devices from a Group a 
Group always has to have at least one Device. If you need to de-select all the Devices then Delete the Group. 
This can be done by selecting Delete in the previous step, see Figure 87. 

2.7.7 Device Sensor Lists 

Note: For systems with less than 200 sensors, Device Sensor Lists have no effect.  

These list all the sensors associated with a Device Group. The signal from a given sensor can be received by 
more than one Base Unit (Network Receiver, see Part 1, section 2.1). You can select a particular sensor 
instance (for example, the one with the highest signal strength) and assign it to the associated Device Group. 
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To display a Control Device Sensor List select Device Sensor List from the menu on the left to give the 
Control Device Sensor List window, see Figure 89 below. 

 

Figure 89 

Note: You cannot create (or delete or edit) a Control Device Sensor List. These are created by Notion Pro as 
sensors are added to the System. 

Select the Site of interest from the ‘Site Name’ list. You must select a Site. Select the Sub Site of interest from 
the ‘Sub Site Name’ list, and the Control Device Group of interest from the ‘Control Device Group’ list. It is not 
necessary to specify a Sub Site or a Control Device Group, in this case a list of sensors for all Sub Sites and 
Device Groups will be generated (as in the example in Figure 89 above). Click Search to generate the list. 

To assign a sensor to its associated Device Group, select the tick box on the left side of the table, 

then click Assign . The list will be redisplayed with assigned sensors highlighted. (In Figure 89 above, three 
sensors have already been assigned to the ‘LongTermTest’ Device Group. 

To remove a sensor from its associated Device Group, select the tick box on the left side of the table for the 
sensors you wish to remove, then click Remove. The list will be redisplayed with assigned sensors highlighted. 
(In Figure 89 above, three sensors have already been assigned to the ‘LongTermTest’ Device Group). 

As another example, Figure 90 below shows a case where signals from two sensors (05-09-00-62 and 05-09-
00-46) are each being received by two Network Receivers. The user has selected the two sensors with the 
highest signal strengths to link to a Device Group. 
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Figure 90 

2.7.8 Adding Alarm Unit Sensors 

This facility supports the operation of the Notion Alarm Unit (the ARB Module, see Part 1, section 2.4) and 
enables you to associate sensors with the unit. Select Add Alarm Unit Sensors from the side menu, see 
Figure 91 below. 
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Figure 91 

Site Name 

Select the Site which contains the Alarm Unit of interest from the pull-down list. 

Sub Site Name 

Select the Sub Site (if present) which contains the Alarm Unit of interest from the pull-down list. 

Zone Name 

Select the Zone which contains the Alarm Unit of interest from the pull-down list. 

Alarm Unit Name 

Select the Alarm Unit of interest (previously created using the Add Device facility described at section 2.7.3). 
The Add Alarm Unit Sensors dialog box changes to show a list of the sensors which can be associated with 
the Alarm Unit. See Figure 92 below for example. 
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Figure 92 

To associate sensors with the Alarm Unit select the required sensors from the Non-Members list then select 

 to move the selected sensors to the Members list. Click Add Members to move the selected sensors to 

the Members list. The View Alarm Unit Sensors dialogue box will appear to show the sensors which have 
been associated with the Alarm Unit. See Figure 93 below for example. 
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Figure 93 

2.7.9 Editing/Viewing Alarm Unit Sensors 

To edit or view associated Alarm Unit sensors select Edit/View Alarm Unit Sensors from the menu to give the 
View Alarm Unit Sensors window, see Figure 93 above for example. 

To the list of sensors associated with a given Alarm Unit, select Edit in the line corresponding to the Sensor list 
that you wish to Edit. A new window called Edit Alarm Unit Sensors will appear, see Figure 94 below. 
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Figure 94 

To remove sensors from the list highlight them in the left hand column then select  . The double left 

arrows will de-select the selected sensor(s) and move them to the left column. Having de-selected the required 
sensors click Update to update the list. 
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3 Setting Up the Sensor Model 

During the Notion Pro installation process a default Site will have been created. You can Edit the details for the 
default Site, see section 2.6. The first time you run Notion Pro the System Overview screen will look 
something like Figure 95 below. 

 

Figure 95 

Before you can start monitoring temperature, humidity and other data you will need to add some sensors to 
Notion Pro. 

Each main Site can have any number of Sub Sites. Sensors added to a Site can be sub-divided into Zones. 
Zones are viewed in a familiar Windows-style tree, see Figure 96 below. 

 

Zones allow large systems to be sub-divided into logical groups of 
sensors.  

 

Zones can also be used when granting viewing Privileges. When a 
Site contains many sensors, just granting Privileges for a whole 
Site could still lead to a single User being overloaded with data that 
doesn’t relate to that User. Zones can be allocated to Users as well 
as Sites. 

 

Individual sensors can’t be allocated in Privileges only Sites and 
Zones. There is no practical limit to the number of Zones that can be 
added to the system. To allocate an individual sensor to a User add 
a Zone for that sensor. 

 

Figure 96 
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3.1 Adding Zones 

Zones are used to logically group sensors, this could be all sensors of the same type or all the sensors in a 
particular area. For example a Zone could be called RH&T Sensors which contains all the humidity and 
temperature sensors, or First Floor Sensors which contains sensors of different types but which are all on the 
first floor. 

During installation a default Site is created. This Site contains one empty Zone called Zone1. 

An example of a Zone which has had Sensors added and which has live data coming through is shown in 
Figure 97: 

 

Figure 97 

Figure 97 is for the ‘Stores’ Zone. Notice that the ‘column headers’ are just the same as in Figure 98. See 
Section 4 for full details of the Live Data viewing facilities in Notion Pro. 

To Edit and add Zones select View Data from the System Overview display for the Site of interest then View 
Data>Edit Mode from the main menu bar, see Figure 102 below. 

A new window will appear. This window will, as we add Zones and sensors become the main data viewing and 
access window, see Figure 98 below (for the default Zone, Zone1). 

 

Figure 98 

To add a new Zone select  Add Zone from the main View Data menu, see Figure 99 below. 
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Figure 99 

A new window will appear, see Figure 100 below. 

 

Figure 100 

To add a new Zone, enter a name into the Zone Name field. For this example we will call the Zone Outdoor 
Sensors. When happy select Add Zone. You will now see that another Zone has appeared in the tree, see 
Figure 101 below. 

 

Figure 101 

3.1.1 Editing Zones 

Edit Mode is only available if you have the correct access Permissions. If you do not have the required access 
permissions you will see the following message: 

Access Denied. You are not authorised to perform this task, please contact your System Administrator. 
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Figure 102 

After selecting Edit Mode the Sensor and Zone editing/configuration window appears, see Figure 103 below. 

 

Figure 103 

To Edit the Zone select Edit Zone. the Edit Zone window will appear, see Figure 104 below. 

 

Figure 104 

Select a name for the Zone that will make it easy to identify either the type of sensors in the Zone or the 
location of the Zone. In this example we are changing the Zone1 name to ‘Room RH + T Sensors’. Enter the 
name into the Zone Name field, once happy select Update, see Figure 105 below. 

 

Figure 105 



System Manual 

Setting Up the Sensor Model 
 

 

 

 
IM5521-1 Page 99 of 174  

 

3.1.2 Deleting Zones 

To delete a Zone select the tick box next to the Zone that you want to delete then select Delete Zone. You 
cannot delete a Zone with Sensors still in the Zone, see Figure 106 below. 

 

Figure 106 

Delete all sensors in the Zone then repeat the steps above to delete the Zone.  

3.2 Adding Sensors 

Now that we have added some Zones we can now add some Sensors. Before adding Sensors you need to 
select the Zone that you wish to add Sensors to. To add Sensors select View Data>Edit Mode, then select 
Add Sensor to Zone. A new window called Add Sensor will appear, see Figure 107 below. 

 

Figure 107 

You will notice that the Room RH + T Sensors Zone is highlighted (because it is at the top of the list). This is 
the Zone that the new Sensor will be added to. If you wish to add a sensor to another Zone, simply click on the 
Zone name. 

Sensor Name: 

Here you can type a name for the Sensor that means something in relation to either the type of measurement 
that the Sensor is making or the location, for example, Room 1 RH/T. 

Family Type: 

The ‘family’ for the sensor you are adding. Select from iSense, Notion or Legacy / Scout. 

Sensor Type: 

Select the type of Sensor you are adding from the drop down menu, a detailed list explaining all the Sensor 
types can be found on our website at http://www.the-imcgroup.com/notionpro. 

For this example we will add a temperature sensor, the standard temperature and humidity sensor can be 
found in the list as Notion Temperature/RH. 

Hardware Serial No: 

This is the transmitter serial number and can be found on the back of the transmitter, for example: 50-00-02-08. 
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Note: if the sensor has already been added, you would get an error message, as shown in below: 

 

Figure 108 

Control Device Group: 

The Control Device Group contains wireless receiving devices that will receive the data from the transmitters. 
The Control Device Group is selected from the drop down menu, select the Group that corresponds to the Site 
and is compatible with the wireless transmitters used at that Site. For more details see section 2.7.3. For this 
example, we are going to select Notion Pro Group. 

Once you are happy with the details select Add Sensor. You will now see that the Zone icon has a + symbol to 

the left of the icon and that the sensor we have just created has appeared in the table on the right hand side of 
the screen. See Figure 109 below. 

 

Figure 109 

You can add more sensors by repeating the steps above. When adding more sensors additional Zones can 
also be added and additional sensors added to those Zones. Sensors can be edited or deleted by selecting 
either Edit or Delete in the line corresponding to the sensor to be edited or deleted. 

3.2.1 Copying Sensors 

Sensors can be copied from on Zone to another. There are cases where you may want to have the same 
sensor duplicated in different Zones. 

Example 1 

When a site has an outdoor sensor it is desirable to have this sensor available in every Zone. The data from an 
outdoor sensor can be compared with sensor data from individual rooms to see if the conditions inside are 
being driven by the conditions outside. This is a good indicator of how well HVAC systems (Heating, Ventilating 
and Air Conditioning) are performing. 

Example 2 

Rooms that have many enclosed spaces such as fridges in a hospital or display cases in a museum can benefit 
from being able to compare sensor data. A gallery with 20 display cases all with RH/T sensors could be 
compared with an RH/T sensor placed in the open gallery. By comparing the data you can see if the conditions 
outside are driving the conditions inside the cases. 

To copy sensors, highlight in the Zones list the Zone that you want to copy sensors to then select Copy Sensor 
from the Zone dialog box. The Copy Sensors to window appears, see Figure 110 below. You will notice that 
the name of the Zone that the sensors are going to be copied to forms part of the window name. 
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Figure 110 

Select the Zone that you want to copy the sensor/s from. The names of the available sensors in that Zone will 

appear in the left column. Highlight the sensor/s you wish to copy then click . This will move the highlighted 

sensor/s to the column on the right. When happy with the details select Submit. To copy all the sensors click 

. 

3.2.2 Deleting Sensors 

There are three methods to delete Sensors: 

 Select the tick box to the left of the sensor names that you want to delete on the Zone dialog box then select 
Delete Sensor from the top menu. This will delete all highlighted sensors. 

 Select Delete in the row corresponding to the sensor you wish to delete. This will delete only that sensor. 

 To delete all sensors in the table, select the tick box on the left of the title row (next to Sensor Name), then 
click Delete Sensor. 

Warning: Deleting Sensors cannot be undone.  
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3.3 Configuring Sensors 

This section takes you through the configuration of the Sensor properties which include General Settings, 
Scale, Alarms and Filters. 

3.3.1 Accessing Sensor Properties 

To access Sensor properties highlight the Zone name that contains the Sensor that is to be edited, see Figure 
111 below. 

 

Figure 111 

To see the available Sensors click on the + symbol next to the highlighted Zone. The selected branch will 
expand showing all the available sensors, see Figure 112 below. 

 

Figure 112 

To view the properties of the Sensor that is to be edited click on the + symbol next to the Sensor name. This 
will expand the branch again, see Figure 113 below. 

 

Figure 113 

To access the individual Sensor properties click on the + symbol next to properties this will expand the branch 
again, see Figure 114 below. 

 

Figure 114 
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3.3.2 General Properties 

To edit the General Sensor Properties click on General. This opens the General Information window, see 
Figure 115 below. 

 
Figure 115 

Station Name: 

The Station Name can be changed, be aware that changing the name may be confusing for other Users as the 
Station Name normally relates to the physical location of the Sensor. Changing the Station Name no longer 
starts a new data file. 

Family Type: 

Notion. 

Sensor Serial No: 

This is set when the Sensor is added to the system. 

Units: 

This is the units for each of the channels for the Sensor. These cannot be changed here (but see Section 4.7) 
as they are set by the Sensor install. 

Sensor Out of Service: 

This feature allows you to temporally take a sensor out of service. This is useful if the Sensor is measuring 
something that is turned off for a period and monitoring is not required. It avoids alarms being generated while 
the Sensor is not required. Out of Service Sensors are displayed with blue text in the Live View. 

Location: 

The Location field allows you to put a note against the sensor to assist with physically locating the Sensor 
within a building. This is an aide-mémoire and serves no operational function within the software and is not 
mandatory.  

Once you are happy with any changes select Update. 

3.3.3 Scale 

To access Scale properties click on the + symbol next to Scale and the tree will be further expanded, see 
Figure 116 below. 
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Figure 116 

The Scale section allows you to set Graph Scaling, Decimal places and the Next Due calibration date for 
Calibration Reports. 

If you have iSense Sensors, then this section will allow you to enter the correct calibration parameters for those 
sensor(s). See the documentation delivered with the iSense unit for specific calibration details. 

Next Due 

This feature allows the next Calibration due date to be entered into the system. A PDF Report can be triggered 
from the due date field. This is very useful in a regulated environment where exceeding the stipulated 
calibration period would cause a non-compliance. (See section 6.2 for more information on Calibration 
Reports.) 

To access Next Due click the link, the Next Calibration Due Date window appears, see Figure 117 below. 

 

Figure 117 

To change the due date enter the new date into the Date field (in YYYY-MM-DD format) or click on the calendar 
icon and select the required data. If the Sensor has just been added to the system the date in the form is one 
year from the date that the Sensor was added.  

A typical period  would be 12 months for environments that are contaminated or the constant operating 
humidities are very high. Where the environments are clean and the averages humidities are mid-range then 
every 24 months would be acceptable. 

When you are happy with the new date click Update. 
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3.3.3.1 Channel One/Temperature Scale 

To enter the Temperature scale page select Temperature. The Temperature window appears, see Figure 118 
below. 

 

Figure 118 

Each Sensor is installed with a default range. These are only a suggestion and can be changed to suit your 
requirements. 

The defaults can be re-loaded by selecting Set Default, you will be asked to confirm see Figure 119 below. 

 

Figure 119 

Once the new Scale details are known these can be entered into the table in Figure 118 above. Select Update 
to confirm the details. If correct the following message will be displayed, see Figure 120 below. 

 

Figure 120 

3.3.3.2 Channel Two/Humidity Scale 

To access the Humidity scale settings click Humidity and repeat the steps in 3.3.3.1. 

Note: Not all Sensors/Transmitters have two channels, some have only one. 
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3.4 Alarms 

This section will take you through setting Alarms.  

3.4.1 Levels 

To access Alarm Settings click on the + symbol next to Alarms (in Edit Mode). This will expand the branch 
again, see Figure 121 below. 

 

To access Levels click on Levels for one of the sensors. See Figure 122 
below. 

Figure 121 
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Figure 122 

The Sensor in this example is a two-channel temperature and humidity device. You will see two tabs at the top, 
one marked Temperature and highlighted, the other marked Humidity. The highlighted tab is the active tab. 
The tab names will change depending on sensor type, the number of tabs will change depending on the 
number of channels. 

Channel Out of Service 

This feature allows a single channel on a dual channel device to be taken out of service. This is useful as it may 
not be desirable to take the whole device out of service for example if a dual channel temperature transmitter 
was being used to measure the temperatures in a fridge freezer and the freezer had failed or was not in use the 
channel associated with the freezer could be taken out of service. This would allow alarms from the fridge to 
come through the system but there would be no alarms from the unused freezer. 
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To take a channel out of service select the appropriate tab and select the No option button to take that channel 
out of service. When the channel is required again select the Yes option button.   

Alarm Enable 

If a Sensor is temporally out of service, or if the alarms are temporally not required rather than set all the alarm 
settings to zero the alarms can be disabled. To disable the alarms select the No option button. When the 
alarms are required again select the Yes option button.   

High/High High Alarm 

The High High Alarm is the highest level alarm that can be set on the system. This alarm should be set at a 
level that warns the user of potential damage. (High would represent the highest point of the desirable working 
range.) To set the High High Alarm type a value in the text box next to High High. The level can be set to one 
decimal place.  

Low/Low Low Alarm 

The Low Low Alarm is the lowest level alarm that can be set on the system. This alarm should be set at a level 
that warns the user of potential damage. (Low would represent the lowest point of the desirable working 
range.) To set the Low Low Alarm type a value in the text box next to Low Low Alarm. The level can be set to 
one decimal place.  

High / Low Alarm Delay (Mins) 

The high / low alarms can be delayed, which is very useful to prevent false alarms. In many buildings rooms are 
air conditioned to keep the environmental conditions constant. The conditions in any room change when doors 
are opened but soon recover when the door is closed again. 

If alarms are set these could be activated every time a door is opened which would generate many alarms on 
the system. There is a danger with alarms that a syndrome called alarm fatigue develops where alarms are 
generated so frequently that they become an annoyance and are consequently ignored. 

To avoid this a delay in minutes can be set for the alarms. For example when a door is opened the temperature 
drops but has recovered back to normal 10 minutes after the door is closed, without an Alarm Delay an alarm 
would be generated every time the door is opened. With an Alarm Delay of 15 minutes there would be no 
alarm generated however if the door was left open there would be an alarm generated after 15 minutes. To 
enter a High / Low Alarm Delay enter the time in minutes in the text box next to High / Low Alarm Delay 
(Mins). 

Alarm Outside Range 

To activate High / Low Alarms click the Yes option button. To disable High / Low Alarms click the No option 
button. 

High High / Low Low Alarm Delay (Mins) 

This feature allows a delay to be activated on the High High and Low Low alarms. It is generally accepted that 
no delay is enabled on the High High and Low Low alarms as these are normally the failsafe alarm levels. If 
delays are used here it may be that a very small delay is used to avoid a single reading out of spec generating 
alarms. To put a delay on the High High and Low Low alarms type a value in the text box next to High High / 
Low Low Alarm Delay (Mins), and should be entered in minutes. 

Rate of Change 

This feature activates Rate of Change alarms. Depending on the application a high and low level alarm may not 
work. A Rate of Change alarm is a mechanism that monitors how fast a parameter is changing and generates 
an alarm based on the selected criteria. For example, an alarm could be generated if temperature changes by 
more than 10°C per minute. 

To set the Rate of Change enter a value in the dialog box next to Rate of Change. For example, a value of 10 
would mean 10°C per Rate of Change period, if temperature units are set to °C. (See section 4.7 for how to set 
units.) 
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Rate of Change Period (Mins) 

This feature is used together with the Rate of Change value above. Rate of Change Period is the time period 
associated with the Rate of Change value. This would be entered in minutes, so combined with Rate of Change 
would work like this - if the temperature changed by more than 10°C in 5 minutes an alarm would be generated. 
To set the Rate of Change Period enter a value in the field next to Rate of Change Period (Mins). 

Alarm Disable Start Time 

This feature allows alarms to be disabled during certain time periods. For example if a room is used during the 
day to work on sensitive items, alarms would be required during the day, but not required during the night. To 
set the Alarm Disable Start Time enter the time in the field next to Alarm Disable Start Time and should be 
entered like this: 18:00:00 in hours, (24 hour clock format) minutes and seconds. All alarms will be disabled 
after 18:00. 

Alarm Disable End Time 

This feature works together with Alarm Disable Start Time and sets the reactivation time for alarms. To set the 
Alarm Disable End Time enter the time in the dialog box next to Alarm Disable End Time and should be entered 
like this: 08:00 in hours, (24 hour clock format) minutes and seconds. All alarms for this device will be active 
again after 08:00:00. 

Active Days 

This feature allows alarms to be turned off on certain days. For example where sensitive goods are worked on 
during the week and put away each evening and at the weekend alarms would not be required at these times. 
The weekday alarms are handled by Alarm Disable Start and Stop Times. The weekends can be handled by 
disabling the alarms on Saturday and Sunday. To disable alarms on certain days select the No option button. In 
this example we want to disable the alarms on Saturday and Sunday. To do this select the No option button 
next to Saturday and Sunday. To make those days active again select the Yes option button. 

Once you are happy with your selections click Update. The alarm settings will be saved. The above can be 
repeated for the second tab if applicable. After selecting Update and the settings are saved the settings page 
returns with a message “Record updated successfully” see below. 

 

Figure 123 shows a correctly completed temperature alarm settings page. The actual values will change 
depending on the measuring parameters, every application will be different. The example shows a high level 
alarm of 25.5°C, a low level alarm of 5°C with a delay of 5 minutes. The high range is set to 20°C and the low 
range to 5°C with a delay of 5 minutes. 

There is a rate of change alarm active which will alarm if the temperature changes by more than 10°C in 5 
minutes. All alarms are disabled between the hours of 8am and 6pm and there will be no alarms at any time on 
Saturdays or Sundays. 

Caution: 

Alarm fatigue can be a major problem on automated monitoring systems especially when the alarms can drive 
emails or SMS alerts to call out service personnel.  

There are many circumstances where the conditions of a room or space are not actively controlled and are 
driven by outside forces such as what’s happening next door or the weather outside. In these cases there is 
little point setting alarms that would relate to ideal conditions, especially if those conditions couldn’t be met on a 
daily basis. In these cases it is better to have no alarms set. 

The danger of receiving many alarms that do not have an action where something can be done to prevent the 
reoccurrence of that alarm is the main cause of alarm fatigue. 

If on the same system there was a critical space with high value objects that was controlled by an HVAC 
(Heating Ventilation and Air Conditioning) system, and on system failure an alarm was generated there is a 
great danger that this alarm could be ignored. 
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We are not suggesting that alarms are never set in these conditions just that thought and consideration are 
given during the alarm setting process. 

  

Figure 123 

Digital Alarms are Alarms generated by digital channels that record data from devices such as ‘door open’ 
sensors. Digital channels can only have two states, which are analogous to open or closed. Figure 124 below 
shows the alarm Levels settings view for a Digital channel: 
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Figure 124 

For a door open/close sensor, Alarm on Open would give an alarm if someone opened the door. 

If there are many Sensors/Transmitters on the same system doing the same function in different spaces it can 
be tedious and error-prone to go through all the Sensors/Transmitters on the system. There is a facility to 
change the Alarm settings globally on a number of sensors. 

3.4.1.1 Global Settings 

To make global changes stay on the alarm settings tab that you want to use to update other 
Sensors/Transmitters with and select Global Setting at the bottom of the tab. A new window will appear, see 
Figure 125 below. 

 

Figure 125 

To expand the tree, select the blue arrow to the left of the Site name, see Figure 126 below. 
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Figure 126 

To see the Sensors/Transmitters in a Zone click the blue arrow to the left of the Zone name, see Figure 127 
below. 

 

Figure 127 

To select the Sensors/Transmitters to update the alarm settings either click in the tick box next to the Zone 
name which will select all the sensors in that Zone or individually select each sensor in turn by clicking in the 
tick box next to the Sensor name, see Figure 128 below. 

 

Figure 128 

Once you are happy with your Sensor selections select Submit. The selected Sensors will now be updated 
with the alarm settings from the selected Sensor. This can be checked by going into the alarm properties of 
another Sensor. 
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3.4.2 Advanced 

To edit the Advanced settings select Advanced. A new window called Alarm Advance will appear, see Figure 
129 below. 

 

Figure 129 

Elapsed Time Warning (Mins) 

The elapsed time warning is used to alarm when a signal is not received from a Sensor within the 
predetermined time. In the default settings the Elapsed Time Warning is set to 120 minutes. This can be 
changed to any time up to 999 minutes. It is not recommended to set the Elapsed Time Warnings to very long 
periods. If there are lots of Elapsed Time Warnings being generated this may be an indication of a more serious 
problem such as poor radio coverage. 

The main purpose of the Elapsed Time Warning is to alert you that a problem has occurred such as a Sensor 
has failed, been moved out of radio range or has inadvertently had the battery removed. 

There are occasions where all the sensors in a Zone or Zones that are served by a wireless receiving device go 
into Elapsed Time Warning at the same time. This would be caused by either a failure in the wireless receiving 
device or a network problem causing the wireless receiving device to stop communication with the database. If 
such problems are seen then these need to be investigated. 

To set the Elapsed Time Warning period enter the required time in minutes into the field next to Elapsed Time 
Warning. 

Alarm Reactivation Time (Mins) 

The Alarm Reactivation Time is the default setting for the time between acknowledging an alarm and when 
the system checks to see if the alarm condition has returned to normal.  

If the alarm condition has returned to normal the alarm status will change from amber (acknowledged) to green 
(OK), if after the Alarm Reactivation Time the alarm condition still exists the alarm status will return to red 
(unacknowledged) and create a new alarm on the system.  

The default setting is 60 minutes. To change this enter a new value in minutes in the field next to Alarm 
Reactivation Time.  

Auto Reset 

Auto Reset is used to reset an alarm status to green when an alarm condition returns to normal. The default is 
No which means that all alarms have to be acknowledged. The disadvantage is that a Sensor could go in and 
out of alarm all night but when the User checks in the morning the status shows green, so without looking at the 
graphs or alarm logs they would be unaware of a problem. 

To change the setting select  one of  the Yes or No option buttons as required.  

When happy with the settings click Update. The setting will be saved, see Figure 130 below. 
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Figure 130 

3.4.3 Notes 

To edit the Notes settings select Notes. A new window called Alarm Notes appears, see Figure 131 below. 

 

Figure 131 

This feature allows you to enter notes for an Alarm. This is especially useful for inexperienced operators. The 
system can be set up so that low-level users can monitor the system but can’t make changes. The Alarm 
Notes will give an inexperienced user specific instruction on what to do when an Alarm occurs.  

For example in the middle of the night the temperature increases in a room or space containing high value 
objects, an Alarm is generated and a night shift operative or security guard views the Alarm. The Alarm 
message might say “On a high temperature alarm contact Facilities Management on Ext 235 and report the 
alarm condition and the room location”. This feature means that someone not familiar with an area or its 
contents can still effectively and efficiently deal with an alarm condition. 

To activate this feature type your instruction into the dialog box and when happy select Add. This will add the 
message to this Sensor. This can be set individually for every Sensor on the system. Once the changes have 
been added and are OK you will see the following window, see Figure 132 below. 
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Figure 132 

3.4.4 Filters 

This feature lets you set filter limits for the Sensor. These should only be used in exceptional circumstances. 
For example if a Sensor is located in or near an electrical switch panel which can be very noisy electrically this 
can occasionally cause interference on the radio link, which would be seen on the graph as a large spike in the 
data.  

The filters are designed to remove such interference. If the Sensor is reading temperature and the expected 
range for this application is -10°C to +50°C a filter could be set at say -40°C for the Min Value and +80°C for 
the Max Value. Any readings seen above or below these readings would be rejected. 

To edit the Filter settings select Filters. The Temperature tab (for temperature in this case) will appear, see 
Figure 133 below. 

 

Figure 133 

To activate this feature enter the required Min and Max values in the appropriate fields. The values should be 
whole numbers in the range 50 for the Max Value and -40 for the Min Value. Select Update when finished. (A 
warning message is given if you click on another tab before you’ve selected Update for a change you made on 
the current tab.) Once the data is accepted you will see the following screen, see Figure 134 below. 
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Figure 134 

For dual channel Sensors, repeat the above process for the other channel. 

Note: Setting filters will cause data to be rejected above and below the filter limits. Check that any filter limits 
set are above and below the expected ranges. 
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4 Viewing Data 

This section will guide you through viewing data. 

4.1 Signing In 

4.1.1 First Time Login (Any User) 

To view the Notion Pro website, you will need to open a browser and navigate to the Notion Pro site.  

If you are working on the Notion Pro Server itself, enter http://localhost/NotionPro in the browser’s address field. 

If you are working on a another computer or device, you will need to use the URL supplied by your System 
Administrator or IT Support provider to reach the Notion Pro server. This may be similar to 
ServerName/NotionPro for a LAN connection or www.mycompany.com/NotionPro for an internet connection. 

 

Figure 135 

Once you have navigated to the correct URL, the login screen will be displayed, as in Figure 135 above. Log in 
using the username and password that the System Administrator has given you. 

Enter your username and password to login, then click Sign In. Passwords are case sensitive. 

The first time you log in you must supply the answer to a security question, so if you forget your password in 
the future, you can retrieve it using a procedure which includes supplying the answer to your security question. 
See Figure 136 below. 

 

Figure 136 

http://localhost/NotionPro
http://www.mycompany.com/NotionPro
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Choose your security question by clicking  and choosing from the list. Type the answer into the box below, 
and then click Submit. 

You will now be returned to the login screen see Figure 135 above, where you will again need to enter your 
username and password. 

4.1.2 Subsequent Logins (Any User) 

Once you have navigated to the correct URL, the login screen will be displayed, see Figure 137 below. 

 

Figure 137 

Log in using the username and password that the System Administrator has given you. 

If you have forgotten your password click Forgotten password? and work through the procedure that follows. 
You will need to know the answer to your Security Question to be able to do this. 

4.1.3 Archived Databases 

Archived Databases will probably only be present if the Notion Pro installation at your site has been running for 
some time, and if the System Administrator has performed one or more archive operations. 

If you login as System Administrator, or with a username with the Access Archive Database permission set, 

then the Choose Database screen will be displayed, Figure 138 below.  

If your Username does not have the Access Archive Database Permission set, then Notion Pro will go straight 
to the live system Home screen.  

 

Figure 138 
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To access archived data, click Archive Database, select the required Archive Database, then click Next. For 
detailed information about the Notion Pro Archive / Backup system, see the IceSpy Notion Pro Archive/Backup 
Manual, doc no IM5549. 

4.1 Viewing the Live Database 

To access the live Notion Pro system, make sure Live Database is selected and click Next to give the System 
Overview, see Figure 139 for an example. 

 

Figure 139 

Note: You will only see the Available Sites view if your installation has more than one Site. For a one-Site 
installation, clicking Next will take you straight to the Live View, see Section 4.3. 

4.2 Choosing the Site to View 

On logging in to Notion Pro, you are presented with the System Overview display, see Figure 140. 

 

Figure 140 

The icons under the Alarm Status column in the Available Sites window show the alarm and sensor 
communication status of the Site under the Site Name column on the left. See Section 5 for details of Alarms. 
The available Actions for each Site are: 

View Data (see section 4.3 below.) 

User Alerts Allows you to set up email and SMS Alert Groups – see Section 2.5 above. 

Reports Allows you to create sensor Reports – see Section 6 below. 

Logs Allows you to view and edit System Logs – see Section 7 below. 
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4.3 Viewing Live Data 

To view live data, click View Data from the Available Sites dialogue box (see above). For a Site which has Sub-
Sites you must first click on Sub-Site and select the sub-site of interest to give the Live View window. See 
Figure 141 below. 

 

Figure 141 

See section 4.3.2 for an explanation of the icons on the Live View display. 

4.3.1 Zone Selection 

The example Live Data display above is for sensors in the Stores Zone – see top left corner. To choose 
another Zone, select View Data>Live View and then move the mouse pointer to the right to show the Zones 
within the current Site. See Figure 142 

 

Figure 142 
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4.3.2 Live View Controls and Indicators 

Sensor Name The colour of the text for each named sensor in this column gives an indication of 
its state: 

Black  – sensor giving normal reading, within alarm threshold. 

Red  – sensor in alarm condition. 

Orange  – sensor in alarm condition, but alarm has been acknowledged. 

Blue – sensor is out of service. 

Single clicking on this text gives more information – see section 4.3.3. Double-
clicking opens graphical display of the live sensor data – see section 4.4 

 
Click on this to give a graphical display of the live sensor data – see section 4.4. 

         
These icons indicate the alarm status of the sensor. See Section 5. 

 

 

The current reading for the sensor channel. Typically, channel 1 would be for 
temperature data, channel 2 for relative humidity.  

A red icon indicates that the sensor reading has gone over its alarm threshold 
value.  

 The Door Alarm icons indicate the state of the door alarm channel (if present): 

 

The door is closed. 

 

The door is open and the alarm has not been acknowledged. 

 

The door is open and the alarm has been acknowledged. 

 

There is no door switch associated with this transmitter. 

 The battery icons indicate the state of the battery for the associated transmitter: 

 

Battery is fully charged. 

 

Battery has less than half its life left, but need not be replaced yet. 

 

Battery is very low and should be replaced as soon as possible. 

 

Battery is empty and must be replaced immediately. Note: Scout/Legacy sensors 
do not output battery information and so the battery display symbol will always be 
grey. Check for Elapsed Time Alarms (see Part 2, section 3.4.3, also Part 1, 
section 2.4.3 for details of elapsed time alarms). 
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4.3.3 Alarm Condition Tooltips 

Click once on the sensor name to show the current alarm status for that sensor. See Figure 143 for example. 

 

Figure 143 

Here we see the date and time of the previous reading from the sensor, also the current battery voltage. The 
channel 1 temperature value is below the Low Level value that has been set, and so is giving an alarm. 

An ‘open door’ alarm might be as shown in Figure 144. 

 

Figure 144 
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4.4 The Graphical Display 

To view the graph data for a Sensor click the  icon for the sensor on the Live View. See Figure 145 for an 

example graph. 

   

Figure 145 – Line Graph, Temperature Data 

Here, the graph shows live temperature data, starting at midnight for the ‘Single Int Therm 0103’ sensor. 
Summary data in textual form is shown in the display box under the graph area. 

Double-click on the Sensor Name in the Live View list (see Figure 141) to give the same graph in its own 
window.  

An example of a graph for a two-channel sensor might be as shown in Figure 146. 
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Figure 146 – Line Graph, Temperature Data and Door State Data 

Here we see temperature data in red, door data in yellow. The door sensor graph line indicates the percentage 
of time in each data period that the door was open. This could be one continuous period or an accumulation of 
several periods. In the above example, the door had been left open from approximately 09:30 to 10:15 when it 
was closed and remained closed.   

4.4.1 Display Time Spans 

The graph window defaults to displaying the current day’s data. 

To change the date range for the graphing period, use the Date and Interval controls, see Figure 147 below. 

 

Figure 147 

Select the calendar icon to change the data graphing start date, this is the data that the graph will start from, 
see Figure 148 below. 

 

Figure 148 

The date has been changed to the 8
th
 July 2015. 
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To view data for one week (commencing 12
th
 of October 2015) use the Interval drop down menu and select 

Week, see Figure 149 below. 

 

Figure 149 

Click on View Graph to generate the graph, see Figure 150 below for example. 

 

Figure 150 

To view data for a month follow the steps above selecting a date from the calendar that is a month or more 
prior to the current date, set the Interval to Month and select View Graph, see Figure 151 below. 

 

Figure 151 

Using the tools above the graph window the following functions can be performed. 
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4.4.2 Overlay Sensors 

This feature allows the comparison of one or more sensors. This is particularly useful if you have an outdoor 
Sensor and want to see if the outdoor conditions are driving the conditions indoors. To overlay Sensors, in Live 
View select Overlay Sensors from the bar menu in the Live View window. A new window called Select 
Sensors to Overlay Graph will appear, see Figure 152 below. 

 

Figure 152 

Select the Zone containing the relevant sensors from the Zone Name: pull-down list. See Figure 153 below. 
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Figure 153 

Select the sensor(s) you require from the Source List then click . To select more than one sensor, hold 

down the Ctrl key as you select the sensors, then click . See Figure 154 below. 
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Figure 154 

Once you are happy with your selection, scroll to the bottom of the list and select Overlay, see Figure 155 
below. 

 

Figure 155 

After selecting Overlay you will be asked to confirm your selection, see Figure 156 below. 

 

Figure 156 
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Select YES to confirm and to proceed with overlaying data. The graph window will re-appear with the selected 
Sensors overlaid over the original graph, see Figure 157 below. 

 

Figure 157 

The coloured key below the graph window clearly identifies the overlaid data traces. To see all the key 
information use the scroll bars to view the lower data. To view specific values on the graph a cursor can be 
applied. To use the cursor move the mouse pointer over the graph window and the cursor will appear, see 
Figure 158 below. 

 

Figure 158 
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Keeping the mouse cursor within the graph window, move the mouse to the left and right to move the cursor 
across the screen. As the cursor moves you will see the sensor values along with the date and time changing. 

You can see from Figure 158 that as the outside temperature (red trace) increases the two indoor temperature 
traces (salmon and mustard) are moving up as well. This indicates that the equipment controlling the indoor 
space is not powerful enough to overcome the effects of the outside temperature changes. 

To remove the overlay select the Overlay Sensors button and scroll to the bottom of the Sensor list and select 
Clear Overlay, see Figure 159 below. 

 

Figure 159 

The graph data will return to the original data. 

4.4.3 High Low Alarm 

This feature allows the levels for High / Low alarms to be overlaid on the graph, to use this feature alarm levels 
will need to be set, see section 3.4 on how to set alarms. 

Click on the High Low Alarm button, then the Select Channel to Display High low Alarm Settings window 
appears, see Figure 160 below. 

  

Figure 160 

To bring on the temperature alarms select the option button next to Channel 1 and select Submit. Lines 
representing where the alarm levels are set will appear on the graph, see Figure 161 below. 
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Figure 161 

This gives a clear visual indication if there has been an excursion either above or below the alarm settings. 

To clear the Alarm select High / Low Alarm from the graph window, the Select Channel to Display High / 
Low Alarm Settings window will appear again, this time the Channel that has been put on the graph will be 
highlighted. See Figure 162 below. 

 

Figure 162 

Select Clear High / Low Alarm to remove the Alarms from the graph.  

4.4.4 High High / Low Low Alarm 

This feature has the same function as the High / Low Alarms only this time the High High and Low Low 
alarm levels are overlaid on the graph. Alarms are set in a similar way to High / Low Alarms. To start the 
routine, select High High / Low Low Alarm from the toolbar above the graph window. See section 3.4.1 for 
setting alarm levels (System Administrator Users only). 

The result here might be as shown in Figure 163 below. 
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Figure 163 

(Temperature has gone below the Low Low setting in the above example). 

4.4.5 Reset 

This function will clear the graph window back to the default view regardless of where you are. The default view 
is the current date with one day’s data displayed. To reset the graph select Reset from the menu above the 
graph window. 

4.4.6 Previous 

The Previous function steps you back through the data one graph span at a time. If the Interval is set to Day 
then the graph will step in days, Week and it will step in weeks, Month it will step in months. 

4.4.7 Next  

The Next function steps you forward through the data one graph span at a time. If the Interval is set to Day 
then the graph will step in days, Week and it will step in weeks and Month it will step in months. When a graph 
is first generated the Next button won’t be visible as there is no future data to display. Once you select a time to 
graph in the past the Next button will appear.  

4.4.8 Scale 

The configuration of the graph Scale is selectable. There are three methods of selecting the graph Scale. To 
change the Scale select Scale from the menu above the main graph window. A new window called Select 
Graph Scale will appear, see Figure 164 below. 
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Figure 164 

Default/User Defined Scale 

You can define a default Scale for each Sensor on the system. The User Defined Scale can be set in the 
Scale page see section 3.3.3 (System Administrator Users only). Some Sensors have a very wide operating 
range but the Sensor in question may be being used at one end of the range. A User Defined Scale allows a 
more detailed view of the data. 

Fixed Scale (0-100) 

Each Sensor installs with a Default Scale which would cover the maximum range for that Sensor. This is Scale 
setting is OK if the Sensor is going to be used over its range. If it’s to be used over a smaller range then a User 
Defined Scale may be more appropriate, see above. 

Auto Scale 

This feature allows the graph Scale to be set automatically. Auto Scale will set the graph Scale to a very tight 
range which covers the range for the data displayed. This gives a much expanded view of the data and may be 
confusing as the data can look like it is changing dramatically. 

Select the Scale type you require by clicking the option button next to the Scale Type and select Submit. The 
graph will re-draw with the new Scale settings, see Figure 165 below. 
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Figure 165 

The User Defined Scale for this Sensor is -40°C to +40°C and 0% to 100% Relative Humidity. Using Auto 
Scale has rescaled the graph to -150°C to 23°C and -165% [theoretical] to 20% Relative Humidity. 

4.4.9 Export Data 

The data associated with Day and Week interval graphs can be saved to a comma separated variables file, 
(.CSV). The entire Day or Week’s data will be exported, irrespective of the current zoom state when the data is 
exported. To export data click Export Data. 

Once clicked you may be asked to choose between saving the file and opening with your computer’s default 
spreadsheet application (see Figure 166). However, the exact action will depend on the browser you are using, 
the default settings for your browser and the computer operating system and its setup. If you require assistance 
with this contact your system administrator or IT support provider, please do NOT contact IMC Technical 
Support, as this is help that only your administrator / support provider can supply. 

4.4.10 Print Graph 

The Print Graph function allows you to save a picture of the graph (line or bar chart) in .pdf format. Clicking on 
the Print Graph button gives the browser’s standard “Do you want to open or save . . .” window. (Example 
below is for Internet Explorer.) 

 

Figure 166 

Clicking Open displays the graph in a .pdf window, with IMC headers and footers: 
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Figure 167 

Select File>Save As… to save the file to your desired location with name graph.pdf, renaming the file if 
required. 

4.4.11 Start of Data, End of Data 

Select  Start of Data to change the graph display to the date/time when data was first recorded by the sensor. 
End of Data returns the display to the show data at the current date/time. 

4.4.12 Go Back 

Click this button to go back to the Live View display for the Zone at the top of the Live View list (see Figure 
142). 

4.4.13 Zooming In 

The graph can be zoomed by using the mouse. To Zoom in on a section of the graph place the mouse cursor at 
the place where you want to Zoom in on, click and hold the left mouse button and move the mouse to cover the 
section of the graph to Zoom in on. 

When the area required is highlighted release the left mouse button, see Figure 168 below. 
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Figure 168 

The graph will re-draw, zoomed into the area selected, see Figure 169 below. 

 

Figure 169 

Once the graph has been zoomed a new button (Zoom Out) will appear on the graph toolbar, see Figure 170 
below. 
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Figure 170 

The new button will Zoom the graph out.  You will see that Zoom Out is followed by a number in brackets. In 
the example above (+1) tells you that the graph has been zoomed one time. If the number in brackets was (+3) 
that would indicate that the graph has been zoomed three times. 

Clicking the Zoom Out button once will take you back one step. To go back to no Zoom in one step you can 

select Reset. Once the graph has been returned to an un-zoomed view the Zoom Out button will disappear. 

4.4.14 Graph Title 

The graph title appears above the graph and is auto generated by the system. The name consists of the Station 
name allocated by the user when the Sensor was added to the system and the serial number, see Figure 171. 

 

Figure 171 

4.5 Plan View 

Notion Pro allows the User to allocate Plans to a Zone. Plan View gives a graphical view of the data. To access 
Plan View select Plan View from the View Data menu from the top menu bar, see Figure 172 below. 

 

Figure 172 

To add a Plan select Browse to locate a suitable Plan, suitable Plan formats are .gif, jpg and .png and should 
be no larger than 30K, see Figure 173 below for example. 
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Figure 173 

Once a suitable Plan has been located select Upload to load the image. 

When a plan is first loaded all the sensor icons will be located along the bottom bar. The icons can be dragged 
to the Plan by moving the mouse pointer over the icon, holding down the left mouse button and dragging the 
required sensor icon to the desired location on the Plan, see Figure 175 below for example. You must have the 
Plan View Edit Permission set to Allow to be able to do this (System Administrator users only, unless the 
System Administrator has assigned the permission to you). 

 ‘Out of Service’ sensors are displayed on the Plan View in blue, see Figure 174. 

 

Figure 174 
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Figure 175 

Each channel is represented by a single block. A double-channel device is represented by two blocks, a three-
channel device by three blocks. See Figure 176 for example. 
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Figure 176 

If required all icons can be removed from the Plan to the bottom bar, to perform this function select Reset, you 
will get a confirmation request, see Figure 177 below. 

 

Figure 177 

To continue select YES, all icons will be moved to the bottom bar. 

Moving the mouse pointer over a Sensor icon displays a tool tip with the sensor name and its parent Zone. See  
Figure 178. Click  Re-Activate Tool Tips if the tool tips are not visible. 
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 Figure 178 

4.6 Global Settings 

Global Settings allows alarm disable times and days to be set across a range of Sensors. To access Global 
Settings select Global Settings from the View Data menu from the top menu bar, see Figure 179 below. 

 

Figure 179 

After selecting Global Settings a new page will appear, see below. 

 

Figure 180 

For information on setting times and days see section 3.4.1 (System Administrator Users only), once the times 
and days have been set use the Site and Zone tree on the left side to select which Sites and Zones to apply 
the changes to. (Click on the desired Site, the Zone tree then expands underneath it, see Figure 181 below for 
an example.) 
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Figure 181 

For example, setting Active Days to Sunday to Saturday (Figure 180), then using the tree view illustrated in 
Figure 181 to select those Zones (or individual sensors within the Zones) to which the global settings are to 
apply, then selecting Apply Global Setting will result in all selected sensors becoming active Sunday-Saturday 
inclusive. 

4.7 Global Units 

Global Units allow common Sensor value types to be displayed using alternative units,  for example displaying 
Temperature values as Fahrenheit instead of Celsius. To access the Global Units window, select Global 
Units from the View Data menu, see Figure 182 below. 

 

Figure 182 

After selecting Global Units the Edit/View Global Units window will display, see Figure 183 below. 

 

Figure 183 



System Manual 

Viewing Data 

 

 

 

 
IM5521-1 Page 143 of 174  

 

To change the units used for Temperature, for example, click the down arrow to the right of Default and select 
the required unit option, F or K, see  Figure 184 below, then click Save. When asked ‘Are you sure?’ click YES 
to confirm. 

 

 Figure 184 

4.8 Decimal Places 

The decimal places facility allows you to set the number of decimal places to be used to display sensor data. 
To access the facility, begin by selecting View Data>Decimal Places (see Figure 185) to give the Decimal 
Place Setting window, see Figure 186. 

 

Figure 185 

 

Figure 186 

Enter the number of decimal places you require in the Decimal Places: field and click Submit. A confirmation 
window will appear confirming that the setting has been applied, see Figure 187 below. 

 

Figure 187 
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4.9 Default View 

The Live View is the default view type following Notion Pro install, but you can change this to the Plan View if 
required. To do this, begin by selecting View Data>Default View, see Figure 189 below. 

 

Figure 188 

This selection give the Default View Setting dialogue box, see Figure 189. 

 

Figure 189 

Select the required default view type, then click Submit. 
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5 Alarm Management  

This section will take you through managing alarms generated by the system. When the User first signs in to 
Notion Pro the first screen gives an overview of the system. The overall system alarm status can be seen by 
looking at the Alarm icons under Alarm Status, see Figure 190 below. 

5.1 System Status Overview 

 

Figure 190 

We can see that there are alarms on the Notion Pro Demo Site, but no alarms on the IMC Group Site. 

5.1.1 System Messages  

System Messages can be viewed from the System Message Alert icon, see the example Figure 191 below. 

 

Figure 191 

The three coloured dots indicate the system message status: 

 White there are no system messages 

 Amber there no new unread system messages  

 Red there are new unread system messages 

To view the System Messages click on the System Status message bubble. A new window will appear, see 
Figure 192 below for example. 

 

Figure 192 

The System Messages inform you of where on the system the Alarms are. Once this window is closed the 
System Message bubble changes to amber which indicates that there are still live messages but there are no 
new ones since the last time the System Messages were checked, see Figure 193 below. 

 

Figure 193 

The Status Message bubble is amber. 
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5.1.2 System Alarm Status Overview 

The Alarm icon on the top right of the main screen gives a system wide view of the Alarm status, see the 
example in Figure 194 below. 

 

Figure 194 

The following data is shown: 

 The User that is logged in, in this example it is Admin User 

 The number of unacknowledged alarms, in this example there are three 

 The number alarms awaiting reset, in this example there are none. 

The individual Site icons show the alarm status for that individual Site only, see Figure 190. The  icon 

indicates that Control Device communications are operating normally, (see section 5.1.3 below for details). 

5.1.3 Communications Status 

 The green connection icon, shown under Alarm Status on the Available Sites dialog box,  
indicates that communications to all control devices, (such as Network Receivers), 
associated with the site are operating normally.  

 If communications have been lost to one or more of the sites control devices, the connection 
icon will display in red and entries will be added to the activity log, (see Section 7.1). 

 

5.1.4 Locating Alarms on the System 

There are two ways that you can find Alarms on the system: 

Method 1 

Select Home (or System Overview) from the main menu bar. 

This takes you to the main System Overview (Available Sites) screen (see Figure 190). If any Sites that are 
visible are in Alarm their individual Alarm icons will have turned red. 

Method 2 

Click on the main Alarm icon, see Figure 195 below.  

 

Figure 195 

Wherever you are in Notion Pro, clicking this icon will take you back to the System Overview screen, so you 
can tell which Site(s) contain the sensors that are in alarm.   
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5.2 Acknowledging Alarms 

5.2.1 Acknowledge Individual Alarms 

To acknowledge an individual Alarm click on the Red Alarm Bell in the line in the Live View corresponding to 
the Sensor that you want to acknowledge the alarm for. The Acknowledging Alarm for window appears, see 
Figure 196 below.  

  

Figure 196 

The type of Alarm will be highlighted in Red, in this example it is a High High Alarm for Temperature. If there 
were special instruction added when the alarm parameters were set these would appear in the Instructions text 
box. For more information on Instructions see section 3.4.3 (System Administrator Users only). 

In the User Actions text box enter a note that is relevant to the Alarm, for example “Humidifier out of water, 
humidifier tank filled up”. You cannot acknowledge the Alarm without putting something in this dialog box. 
When happy click Acknowledge. The window will close and the Alarm icon will turn amber which indicates an 
acknowledged state. 

When you are satisfied that either the cause of the alarm has been resolved and the conditions returned to 
normal limits the Alarm can be completed. To reset the alarm click on the amber icon, the Reset Alarm window 
will appear, see Figure 197 below. 
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Figure 197 

This window allows several features to be used. 

The Current Alarm Settings are displayed at the top of the window, if the logged in User has the Permissions 
these limits can be adjusted at this stage. Caution Note: Any changes made here will be written back to the 
main database. 

There are four methods available to reset the Alarm: 

Reactivate Now 

If Reactivate Now is selected as soon as you select Submit the Alarm will be acknowledged. If the Alarm 
condition still exists the status will return to red and a new Alarm will be generated on the system. If the Alarm 
conditions have returned to normal the amber Alarm icon will be removed from the list.  

When selecting Reactivate Now a default message “Reactivate Now was selected for this Alarm” will be 
entered into the Alarm Notes text box. This can be added to or overwritten. 

Time Out 

If Time Out is selected as soon as you select Submit. The Alarm will be acknowledged after the time delay 
entered into the Alarm Reactivation Time (Minutes) dialog box. If the Alarm condition still exists after the 
Time Out period the status will return to Red and a new Alarm will be generated on the system, if the Alarm 
conditions have returned to normal the amber Alarm icon will be removed from the list.  

When selecting Time Out a default message “Time Out was selected for this Alarm” will be entered into the 
Alarm Notes dialog box. This can be added to or overwritten. 
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Return to Acceptable Conditions 

If Return to Acceptable Conditions is selected, as soon as you select Submit the Alarm will be 
acknowledged as soon as the conditions return to normal limits. The amber Alarm icon will remain until the 
conditions return to normal limits.  

When selecting Return to Acceptable Conditions a default message “Return to Acceptable Conditions 
was selected for this Alarm” will be entered into the Alarm Notes text box. This can be added to or 
overwritten. 

Timed Reset Override 

This feature allows you to defer the Alarm reset until a date in the future. To enter the required date select the 
calendar icon and select the date. This will be entered in the dialog box next to Reset Date. Select the time of 
day from the Hours and Minutes drop down menus. 

This feature would be used if for example the air conditioning in a room or space failed and it was going to take 
several days to get an engineer in to carry out repairs. In this case the Alarms would be going off all the time 
which is an inconvenience. 

Using this feature requires you to manually enter a note into the Alarm Notes text box. A suitable note might 
be “Engineer called to repair Humidifier unable to attend site before next Friday” 

When happy with the details select Submit. 
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6 Reports 

 

Notion Pro can produce a variety of Reports. These can be tailored to a customer’s individual specifications. 
The report will be in PDF format with the option to have a CSV data file attached. 

Scheduled Reports are user configurable and once configured to be auto generated on a daily, weekly or 
monthly basis and sent to the user by email. The on-screen reports can be downloaded and saved in PDF 
format. 

Four types of Report can be produced: 

6.1 Summary Reports 

(Reports>Browser Summary Reports) 

These can be divided into two sub-types: 

- Sensor Reports - Summaries of data collected over the past week by selected sensors. You can 
also generate Reports for sensors of a selected type (temperature for a Temperature Sensor, current 
for an Energy Sensor etc.) over a specified date range (the past week by default). 

- Zone Reports - Summaries of data collected by all Sensors in a given Zone for a specified date 
range. 

To generate a Summary Report: 

1. Select Reports>Browser Summary Reports to give the Browser Summary Report dialog box, see 
Figure 198 for example. 
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Figure 198 

The sensor list is for all sensors of all types across your Site. To report on one or more Sensors: 

1. Ensure that the Sensor option button is selected. 

2. Select the sensor(s) of interest from the Sensor Name list. If the list of sensors is long you may need to 

click on   to see the next page in the sensor list. To select all sensors in the list simply click in the tick 

box next to Sensor Name at the top of the list. 

3. Select Generate Report. 

This gives a report in .pdf format. For example, see Figure 199: 
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Figure 199 

Note that you need to use the scroll bar at the top (or bottom) to see all of the Report. If you wish to save the 

report, click on  to give the standard browser Save dialog box (example below is for Internet Explorer): 

 

Select Save or Save as to save the .pdf file to the required location. 

There may be sensors that you often wish to report on. You can specify these as ‘favourite’ sensors. To do this, 
select the grey star symbol next to the sensors of interest. The star colour changes to blue and the row 
containing the sensor becomes highlighted. See Figure 200  for example: 

 

Figure 200 
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Having specified your ‘favourite’ sensors, select Add to Favourites. If you then nominate other sensors as 
‘favourites’ select the grey star for the sensors of interest then select Update Favourites. 

Your favourite sensors will then move to the top of the Sensor List and Generate Report will generate a report 
for your favourite sensors. 

Having generated a Report, to generate Summary Reports for a selected sensor type over a specified date 

range, first use the  icon to choose the required Start and End dates (or enter the required dates directly 

into the Start Date and End Date boxes), then select the required sensor type from the Select Sensor Type pull-
down list. Click Search to generate the specified Report. See Figure 201 below. 

 

Figure 201 

Note: you will only see the date range selection controls after you have already generated a Report. 

To report on a Zone, ensure that the Zone option button is selected. Click Search to generate a list of Zones for 
your Site. See Figure 202  for example. 

 

Figure 202 

To generate a report for all sensors in a Zone simply select the Zone of interest from Zone Name list then 
select Generate Report. You can select ‘favourite’ Zones, or sensor types and date ranges using the same 
methods as detailed above for sensors. 
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6.2 Calibration Reports 

(Reports>Browser Calibration Reports) 

A simple report of sensors that need calibrating on a given date. This is one month from today’s date by default, 
but the example below shows sensors due for calibration within one year of the current date. 

For example: 

 

Figure 203 

To generate a Calibration Report select Reports>Browser Calibration Reports, see Figure 204 below: 

 

Figure 204 
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By default, a Report will be generated for all sensors which need to be calibrated one month from today's date. 
If you wish to select a different due date, clear the ‘Keep Default Due Date’ tick box then click the Due Date 
calendar and select the required date. There may be Sensors on your Site which are out of service, but may 
still be due for calibration. If you wish to include such sensors in the Report select 'Include Out of Service 
Sensors' tick box if. Click Search to generate the specified Report. 

6.3 Exception Reports 

(Reports>Browser Exception Reports) 

Reports on ongoing alarm conditions, by Sensor or by Zone. 

Selecting Reports>Browser Exception Reports gives the Browser Exception Report dialog box, see Figure 
205 below for example. 

 

Figure 205 

The sensor list is for all sensors of all types across your Site. To report on one or more Sensors: 

1. Ensure that the Sensor option button is selected. 

2. Select the sensor(s) of interest from the Sensor Name list. If the list of sensors is long you may need to 

click on   to see the next page in the sensor list. To select all sensors in the list simply click in the tick 

box next to Sensor Name at the top of the list. 

3. Select Generate Report. 

This gives a report in .pdf format. See Figure 206 below for example. 
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Figure 206 

Note that you need to use the scroll bar at the top to see all of the Report. If you wish to save the report, click 

on  to give the standard browser Save dialog box (example below is for Internet Explorer): 

 

Select Save or Save as to save the .pdf file to the required location. 

There may be sensors that you often wish to report on. You can specify these as ‘favourite’ sensors. To do this, 
select the grey star symbol next to the sensors of interest. The star colour changes to blue and the row 
containing the sensor becomes highlighted. See Figure 207  for example: 

 

Figure 207 

Having specified your ‘favourite’ sensors, select Add to Favourites. If you then nominate other sensors as 
‘favourites’ select the grey star for the sensors of interest then select Update Favourites. 

Your favourite sensors will then move to the top of the Sensor List and Generate Report will then generate a 
report for your favourite sensors. 

Having generated a Report, to generate Exception Reports for a selected sensor type over a specified date 

range, first use the  icon to choose the required Start and End dates (or enter the required dates directly 

into the Start Date and End Date boxes), then select the required sensor type from the Select Sensor Type pull-
down list. Click Search to generate the specified Report. 

Note: you will only see the date range selection controls: 

 

after you have already generated a Report. 
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To report on a Zone, ensure that the Zone option button is selected. Click Search to generate a list of Zones 
for your Site. See Figure 208 for example. 

 

Figure 208 

To generate a report for all sensors in a Zone simply select the Zone of interest from Zone Name list then 
select Generate Report. You can select ‘favourite’ Zones, or sensor types and date ranges using the same 
methods as detailed above for sensors. 
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6.4 Scheduled Reports 

(Reports>Schedule Reports) 

These cover a variety of Report types, which can be set up to start and end at predefined dates/times and can 
run at predefined intervals. 

For example: 

 

Figure 209 

The above would generate a .pdf report which would be emailed to the System Administrator user(s). See Figure 
210. 

 

Figure 210 

The Sensors to be reported on and the Contacts who are to be emailed the report are defined in a similar way 
to the method used for Email Alert Groups, see section 2.5.1. 
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As an example, the steps to set up and run the Scheduled Report shown in Figure 210 might be: 

1. Select Reports>Schedule Reports. Note  on the side menu is highlighted – we are 

defining a new Report. 

2. Select Summary Report from the Report Type: pull-down list. 

3. Enter a title for the Report in the Report User Title box, for example ‘Sys Admin Summary Report’. 

4. Select a date and time for the first Report run using the First Report Run: controls. This should be later 
today or any time in the future. 

5. Report Interval is the length of time between repeated runs of the Report, for example an interval of one 
day would give daily Reports. You don’t have to specify a Report Interval, this would give a ‘one off’ Report. 

6. Use the Report Start: and Report End: controls to specify the time span for the Report. This would typically 
be dates in the past, but could be dates in the future (although if, for example you specified a start date one 
week in the future and end date two weeks in the future you would have to wait 2 weeks before you saw a 
Report). In our example 17 June 2015 has been set at the start date, 1 July 2015 as the end date. 

Note: you should set an Interval, with no Report Start or Report End time, or a Report Start and Report End 
time, (but no Interval). 

7. Having set up the Report dates, we now need to specify the Sensor data that we wish to report on. Click 
the Sensors tab, then click Add Sensors to give the Add Sensors dialog box, see Figure 217 below for 
example: 

 

Figure 211 
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8. Select the Zone that contains the sensors you wish to report on from the Zone Name pull-down list. The 
Source List becomes populated with the sensors in the selected Zone. See Figure 212 below for example: 

 

Figure 212 

9. Select a sensor in the Source List that you wish to report on, and select  to transfer it to the 

Destination List. To transfer all sensors in a single operation click . When the Zone name list is long 

the required Zone can be found by using the Filter. See Figure 213 for an example of a populated 
Destination List. 
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Figure 213 

10. When satisfied with your selections, select Submit.  

11. Now we need to specify a list of Users (System Contacts) that the report will be emailed to. Click the 
System Contacts tab, then click Add Contacts to give the Add Contacts dialog box. See Figure 214 
below for details. 
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Figure 214 

12. Populate the Destination List for System Contacts using the same methods that you used to populate 
the Destination List for Sensors (see step 9 above). When satisfied with your selections click Submit. 

13. If any External Contacts have been set up and you wish to send the Report to them, select the External 
Contacts tab and populate and Submit it in the same way as for System Contacts. 

14. When satisfied with all of your Report Settings, select Submit under the Add Scheduled Report Settings 
banner. 

The Scheduled Report you have defined will now be added to the View Scheduled Reports window. See 
Figure 215 below. 
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Figure 215 

To change the Report settings, click on Edit Settings. 

Note: If your Email Server has been set up to limit the maximum allowed email/attachment size, then 
Scheduled Reports in excess of the size limit will be blocked by your Email Server. Note that because 
there is no standard mechanism for feeding this eventuality back to the email client, Notion Pro cannot 
know that these emails have been blocked by the server. Most Email Servers inform the sender of this 
situation by placing a message in the sender account's Inbox. 

  If Scheduled email Reports are not being sent, check the Inbox for the sender account you set up in 
Notion Pro. 
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7 System Logs 

Notion Pro has a series of System Logs for keeping track of critical events such as system activity, alarm 
activity and SMS activity. 

To access the System Logs select Logs from the main menu, see Figure 216 below. 

 

Figure 216 

7.1 Activity Log 

The Activity Log contains all the user activity on the system such as logging in and out and editing. To access 
the Activity Log select Logs>Activity Log from the main menu. The Activity Logs window appears, see 
Figure 217 below. 

 

Figure 217 
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The Activity Log follows system events. Each entry is date and time stamped with a description of the action 
carried out or activity and the user.  

There is a memo field that may or may not contain any memos, for example an activity such as User logged out 
would not have a memo as it is created by the system when the user logs out. If required you can select the 
memo icon next to an activity and add a memo. See Figure 218 below. 

 

Figure 218 

When happy with memo select Submit. 

The memo will now be saved in the top section under existing comments, these comments are date and time 
stamped and are identified by user and are now not editable, see Figure 219 below. 

 

Figure 219 

Additional comments can be added at any time. 

To search back through previous Activity Logs use the Search function, see Figure 220 below. 
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Figure 220 

Use the two calendars to select a Start Date and End Date and select Search. All Activity Logs between these 
dates will be displayed. 

To move through available log pages, use the blue left and right arrows at the bottom of the page. The single 
blue arrows will step through one page at a time, the double blue arrows will take you to either the first page or 
the last page of the search, see Figure 221 below. 

 

Figure 221 

7.2 Alarm Log 

The Alarm Log contains all the alarm activity on the system. To access the Alarm Log select Logs>Alarm Log 
from the main menu. The Alarm Logs window appears, see Figure 222 below. 

 

Figure 222 

The Alarm Log contains date and time stamped data, Alarm Type, Sensor Name, Channel, Acknowledged 
By, Extra Info and a Memo. Extra Info is a link to a floating tip, the tip contains Site and Zone name 
information. 

The Memo contains information on alarm reasons and action taken. Additional notes can be added at any time. 
These notes are not editable. Notes are added by following the steps in Activity Logs above. 

More Alarm Logs can be viewed by using the calendar Search function. 

To move through available Alarm Log pages, use the blue left and right arrows at the bottom of the page. The 
single blue arrows will step through one page at a time. The double blue arrows will take you to either the first 
page or the last page of the search. 
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7.3 SMS Log 

The SMS Log contains entries for all system SMS activity. To access the SMS Log, select Logs>SMS Log 
from the main menu. The SMS Logs window appears, see Figure 223 below. 

 

Figure 223 

The SMS Log contains date and time stamped data, Activity details, Contacts and a Details or memo field. 

The SMS Details contains details of the message sent including User name and the contact number that the 
SMS message was delivered to, see Figure 224 below. 

 

Figure 224 

The example shown above is a regular system heartbeat message sent to the Admin User. More SMS logs can 
be viewed by using the calendar search function. 

To move through available SMS log pages, use the blue left and right arrows at the bottom of the page. The 
single blue arrows will step through one page at a time. The double blue arrows will take you to either the first 
page or the last page of the search. 
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7.4 Email Log 

The Email Log contains entries for all system email activity. To access the Email Log, select Logs>Email Log 
from the main menu. The Email Logs window appears, see Figure 225 below. 

 

Figure 225 

The Email log contains date and time stamped data, Activity details, Contacts and a Details or memo field. 

The Email Details contains details of the message sent including User name and the contact email address 
that the Email was sent to, see Figure 226 below for example. 

 

Figure 226 
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8 Sensor Groups 

Notion Pro has the capability to group sensors of the same type together into Sensor Groups. The Sensor 
Groups feature is extremely useful for grouping sensors of the same time that are measuring the same 
parameters. Sensors from different Sites can be added to one Sensor Group. 

Sensor Groups are also used to control Network Receiver Alarm Relays, SMS Module Alarm Relays, and 
associated MS1000 Control Interface outputs via the Local Alarms settings. 

To create a Sensor Group select Settings>Customise Sensor Groups from the main meu, see Figure 227 
below.  

 

Figure 227 

The Create Sensor Group window appears, see Figure 228 below. 

8.1 Creating Sensor Groups 

 

Figure 228 

Enter a name for the Group this could be “Door Sensors”. Select the Site from the drop down menu next to 
Site Name. For this example we will select Notion Pro Demo. If the selected Site contains Sub Sites, these can 
be selected from the Sub Site Name drop down menu. 

After selecting the Site the available Zones on that Site become visible, select the + symbol next to the Zone 
name that contains the Sensors that you wish to select. Here we will select the sensors which have a door 
channel.  

Once you are happy with your selections select Create Group. The View Sensor Groups window appears, 
see Figure 229 below. 
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Figure 229 

This list contains all the Sensor Groups that are available. Each Sensor Group can be Edited or Deleted.  

8.2 Local Alarms 

Sensor Groups are used to control Local Alarms on Network Receiver, Alarm Unit and SMS Unit devices. If an 
alarm is activated for a Sensor that is a member of the Sensor Group, then the associated Local Alarm will be 
activated on the device.  

8.2.1 Setting up Local Alarms 

Firstly create a Sensor Group, as described in section 8.1 above, adding the required Sensors. 

Once the required Sensor group is created, select Edit/View Sensor Group in the left hand menu, see Figure 
230 for example. 

 

Figure 230 

Now click on the Edit action for the new Sensor Group. The edit view will be displayed, see Figure 231. 

 

Figure 231 

Click the Local Alarms button to display the Local Alarms view, see Figure 232. 
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Figure 232 

Click on the Device Type combo control, and select the required control device type – Notion Base [Receiver 
Unit], IMC Alarm Unit or IMC SMS Unit, see Figure 233, then click on the Device Name combo control and 
select the require device by name. 

  

Figure 233 

The view will now change to display device information and Local Alarm options, see Figure 234 for example. 

 

Figure 234 

To use the Relay output, select the Relay Output option button.  

If you wish to use an output on a MS1000 card; select the option button adjacent to the MS 1000 Channel text, 
this displays the MS1000 channel options, see Figure 235.  
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Figure 235 

Select the required channel number (up to 32 channels are available). When the required Local Alarm has 
been selected, click Set Alarm to save the setting. 

8.3 Viewing Sensor Groups 

To view a Sensor Group select Sensor Groups from the Home menu bar to give the Available Groups 
dialogue box, see Figure 236 below. 

 

Figure 236 

The Available Groups dialogue gives you an alarm status summary for the sensors which form the group. 
Clicking View Data shows you the Live View for the sensors in that group. See Figure 237 below for example. 

 

Figure 237 

See Section 4 for details of the facilities available from the Live View window. You can also generate Reports  
for the sensors in the Group by clicking on Reports. See Section 6. 

Note:  An unlimited Sites and Sensor Groups licence can be purchased, IMC product code W604. Contact IMC 
Group Ltd for details.  
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9 Online Help 

 

You can view task-driven Help for Notion Pro at any time during normal operation of Notion Pro by selecting 
Help>Notion Help from the menu bar. See Figure 238. 

 

Figure 238 

Help>About Notion gives the current Notion Pro version number. See  Figure 239 for example. 

 

Figure 239 
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10 Browser Issues 

10.1 Microsoft Edge/Project Spartan (Windows 10) 

The local loopback address is disabled by default in the Microsoft Edge / Project Spartan browser; this means 
that by default you cannot browse to <Product name>  using Edge / Spartan on the local <Product Name> 
server.  At the time of writing, the following methods are available for enabling the local loopback address: 

1. Run the following command from an command prompt, running as Administrator: 

CheckNetIsolation LoopbackExempt -a -n=Microsoft.Windows.Spartan_cw5n1h2txyewy 

2. For build 10166 or later you may be able to use the following: open an Edge/Spartan tab and navigate to 
about:flags. Then under Developer Settings select the 'Allow localhost loopback' option. 

Note: at the time of writing Microsoft Edge/Spartan is still an early release and access to settings is in flux. 
Thus neither of the above is guaranteed to work. If you have problems enabling the local loopback 
address please try the following: 

 check Microsoft's technical support websites 

 download and use another browser 

 contact your System Administrator or IT support provider. 

 


